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1. Introduction 
 

1.1 RF-STEEL Add-on Modules 
Both RF-STEEL programs are integrated as additional modules in the graphical user interface 
of the main program RFEM. They are no stand-alone modules, which means that the main 
program is always required. RF-STEEL Surfaces is used for the stress design of surface and 
shell elements. Member elements are designed by RF-STEEL Members. Both modules are 
described in this manual. 

The design relevant input data as well as the internal forces are imported automatically 
when you open the modules. Of course, the design results from RF-STEEL Surfaces and RF-
STEEL Members are also available in the RFEM work window to evaluate them graphically 
and to integrate them into the global printout report. 

RF-STEEL carries out general stress designs according to the elastic-elastic method by calcu-
lating existing stresses and comparing them with the limit stresses. The programs provide 
an expandable material library with the standard-specific limit stresses as well as a compre-
hensive cross-section library for member elements. For each member cross-section, design 
relevant stress points that can also be used for graphical evaluations are already available. 

During the stress analysis process, the maximum stress ratios of surfaces, members and sets 
of members are determined. The governing internal forces of each member and set of 
members are documented additionally. Furthermore, the modules provide optimization op-
tions for surfaces and cross-sections including a transfer function to transfer data to RFEM. 

Separate RF-STEEL design cases allow for a flexible analysis of stresses. The design is com-
pleted by a parts list with quantity surveying. 

Some of the new features in both RF-STEEL modules are the following: 

• Determination of equivalent stresses according to different approaches: 
VON MISES, TRESCA, RANKINE, BACH 

• Selection of calculation method for load combinations 

• Serviceability limit state design by checking surface displacements 

• Output of stress ranges Δ for fatigue designs 

• Optimization of surface thicknesses and option to transfer data to RFEM 

• Selection of a maximum stress ratio for optimization process 

• Export option for modified materials to RFEM 

• Detailed output of different stress components and ratios in tables and graphic 

• Filter function for surface, line and node numbers in tables 

• Output of governing internal forces for sets of members 

• Parts list of designed surfaces 

• Direct data export to MS Excel and OpenOffice.org Calc 

We hope you will enjoy working with the RF-STEEL add-on modules. 

Your team from DLUBAL ENGINEERING SOFTWARE 
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1.2 RF-STEEL Team 
The following people were involved in the development of RF-STEEL: 

Program coordination 
Dipl.-Ing. Georg Dlubal 
 Dipl.-Ing. (FH) Younes El Frem 

Programming 
Ing. Zdeněk Kosáček 
Mgr. Petr Oulehle 
Ing. Tomáš Pecholt 
David Schweiner 

Ing. Roman Svoboda 
Dis. Jiří Šmerák 
Lukáš Tůma 

Cross-section and material database 
Ing. Ph.D. Jan Rybín 
Jan Brnušák 

Program design, dialog figures and icons 
Dipl.-Ing. Georg Dlubal 
MgA. Robert Kolouch 

Ing. Jan Miléř 

Program supervision 
Ing. Hana Robovská 
Ing. Martin Vasek 

 

Manual, help system and translation 
Dipl.-Ing. (FH) Robert Vogl 
Jan Jeřábek 

Dipl.-Ü. (Uni) Gundel Pietzcker 

Technical support and quality management 
Dipl.-Ing. (BA) Markus Baumgärtel 
Dipl.-Ing. (BA) Sandy Baumgärtel 
Dipl.-Ing. (FH) Matthias Entenmann 
Dipl.-Ing. Frank Faulstich 
Dipl.-Ing. (FH) René Flori 
Dipl.-Ing. (FH) Walter Fröhlich 
Dipl.-Ing. (FH) Alexandra Lazar 

M.Sc. Dipl.-Ing. (FH) Frank Lobisch 
Dipl.-Ing. (FH) Alexander Meierhofer 
Dipl.-Ing. (BA) Andreas Niemeier 
M.Eng. Dipl.-Ing. (FH) Walter Rustler 
M.Sc. Dipl.-Ing. (FH) Frank Sonntag 
Dipl.-Ing. (FH) Christian Stautner 
Dipl.-Ing. (FH) Robert Vogl 
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1.3 Using the Manual 
Topics like installation, graphical user interface, results evaluation and printout are de-
scribed in detail in the manual of the main program RFEM. The present manual focuses on 
typical features of the RF-STEEL add-on modules. 

The description of the modules follows the sequence of their input and results tables as well 
as their structure. RF-STEEL Surfaces is described in chapter 2, RF-STEEL Members in chap-
ter 3. The subsequent chapters describe common functions. 

The text of the manual shows the described buttons in square brackets, for example [New]. 
At the same time, they are pictured on the left. In addition, expressions used in dialog 
boxes, tables and menus are set in italics to clarify the explanations. 

Finally, you find an index at the end of the manual. However, if you don’t find what you are 
looking for, please check our website www.dlubal.com where you can go through our FAQ 
pages by selecting particular criteria. 

1.4 Start RF-STEEL Modules 
RFEM provides the following options to start the RF-STEEL add-on modules 

Menu 
To start the programs, 

point to Design - Steel in the Additional Modules menu, and then select RF-STEEL 
Surfaces or RF-STEEL Members. 

 
Figure 1.1: Menu: Additional Modules → Design - Steel → RF-STEEL Surfaces or RF-STEEL Members 

The add-on module RF-STEEL Surfaces (2003) is a previous version. The present manual 
does not go into detail regarding its description. 
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Navigator 
To start the RF-STEEL modules in the Data navigator, 

open the Additional Modules folder and select RF-STEEL Surfaces or RF-STEEL Mem-
bers. 

 
Figure 1.2: Data navigator: Additional Modules → RF-STEEL Surfaces or RF-STEEL Members 

Panel 
In case RF-STEEL results are already available in the RFEM structure, you can set the corres-
ponding RF-STEEL case in the load case list of the RFEM toolbar. By using the button [Re-
sults on/off], you can display the stresses or stress ratios in the graphic. 

If the results display is activated, the panel appears showing the button [RF-STEEL Surfaces] 
or [RF-STEEL Members] which you can use to open the RF-STEEL module. 

 

Figure 1.3: Panel button [RF-STEEL Surfaces] 



2  RF-STEEL Surfaces 

 9Program RF-STEEL © 2010 Dlubal Engineering Software 

    

 

2. RF-STEEL Surfaces 
 

2.1 Input Data 
The data for the definition of design cases is entered in tables. 

When you have started RF-STEEL Surfaces, a new window opens where a navigator is dis-
played on the left, managing all tables that can be selected currently. The pull-down list 
above the navigator contains the design cases that are already available (see chapter 6.1, 
page 82). 

If you open RF-STEEL Surfaces in an RFEM structure for the first time, the module imports 
the following design relevant data automatically: 

• Surfaces 

• Load cases, groups and combinations 

• Materials 

• Surface thicknesses 

• Internal forces (in background, if calculated) 

To select a table, click the corresponding entry in the RF-STEEL navigator or page through 
the tables by using the buttons shown on the left. The function keys [F2] and [F3] can also 
be used to select the previous or subsequent table. 

To save the defined settings and quit the module, click [OK]. When you click [Cancel], you 
quit the module but without saving the data. 

2.1.1 General Data 
In table 1.1 General Data, you define the surfaces that you want to design. The two tabs 
below contain the actions that you can select for the ultimate and the serviceability limit 
state design. 

RF-STEEL Surfaces is able to design both plane and curved surfaces. 

The design standard is specified in table 1.2, even though indirectly, because the material 
properties are related to the standard. 

Design of 
The design is carried out for Surfaces, but the surface thickness in the add-on module is re-
stricted to the thickness types 'Constant" and 'Variable'. If you want to design only selected 
surfaces, clear the All check box. Then you can access the input field to enter the numbers 
of the relevant surfaces. The list of the preset numbers can be selected quickly by double 
click and overwritten by entering the data manually. 

To select the surfaces graphically in the RFEM work window, use the [Pick] button. 

 
Figure 2.1: Graphical selection in the model 
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2.1.1.1 Ultimate Limit State 

 
Figure 2.2: Table 1.1 General Data, tab Ultimate Limit State 

Existing Load Cases / Load Groups and Load Combinations 
These two sections list all load cases, load groups and load combinations defined in RFEM 
that are relevant for the ultimate limit state design. Use the button [ ] to transfer selected 
load cases or combinations to the list Selected for Design on the right. You can also double-
click the entries. To transfer the complete list to the right, use the button [ ]. 

Selected for Design 
The column on the right lists the loads selected for the design. Use the button [ ] to re-
move selected load cases or combinations from the list. You can also double-click the en-
tries. With the button [ ], you can transfer the entire list to the left. 

The stress analysis of an enveloping Or load combination is often carried out more quickly 
than the global design of all created load cases and load groups. When you select load 
combinations, it is recommended to check the settings for Analysis Method for Load Com-
binations in the Options tab of the Details dialog box additionally (see chapter 2.2.1.3, page 
26). 

Comment 
This input field allows for user-defined remarks, for example to describe the current design 
case. 

 



2  RF-STEEL Surfaces 

 11Program RF-STEEL © 2010 Dlubal Engineering Software 

    
 

    

 

2.1.1.2 Serviceability Limit State 

 
Figure 2.3: Table 1.1 General Data, tab Serviceability Limit State 

Existing Load Cases / Load Groups and Load Combinations 
In these two sections, all load cases, load groups and load combinations are listed that have 
been created in RFEM. 

Selected for Design 
Adding and removing load cases, load groups or load combinations is described in the pre-
vious chapter. The serviceability limit state design requires particular partial safety factors 
that can be considered in corresponding combinations of load cases and actions. 

Combination of Actions 
In the lower part of the Selected for Design section, you can assign limit values to the se-
lected load cases, load groups and load combinations with regard to deflection: First, select 
an entry in the Selected for Design list, and then choose one of the three action combina-
tions. To assign the action combination to the selected load case, click the button [ ]. 

The following action combinations are available: 

• Characteristic (CH) 

• Frequent (FR) 

• Quasi-permanent (QP) 

The deformation limit values are defined in the standards and can be modified for the dif-
ferent action combinations in the Serviceability tab of the Details dialog box (see chapter 
2.2.1.2, page 25). 

The reference lengths that are decisive for the serviceability limit state design are deter-
mined in table 1.4 Serviceability Data (see chapter 2.1.4, page 18). 
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2.1.2 Materials 
The table is subdivided into two parts. In the upper part, the materials used for the design 
are listed with the limit stresses. In the Material Properties section below, the properties of 
the current material, i.e. the table row currently selected in the upper section, are displayed. 

The material properties required for the determination of internal forces in RFEM are de-
scribed in detail in chapter 5.3 of the RFEM manual. The design relevant material properties 
are stored in the global material library and are preset automatically but can be adjusted in 
the present table. 

To adjust the units and decimal places of material properties and stresses, select Units and 
Decimal Places in the module's Settings menu. 

 
Figure 2.4: Table 1.2 Materials 

Material Description 
The materials defined in RFEM are already preset. But it is possible to select another materi-
al by using the list: Place the pointer in a table row of column A, and then click the button 
[ ] or use the function key [F7]. The list shown on the left opens. When you have selected a 
new material, the design relevant properties are entered into the corresponding table row 
and are highlighted in blue. 

Only steel materials are available in the list. In principle, you can carry out the design with 
any material whose stress concept is based on the comparison of existing normal, shear and 
equivalent stresses with the respective allowable stresses. Therefore, it would be possible to 
design structural components made of aluminum or stainless steel. However, you must con-
sider the corresponding standard specifications additionally. 

If you have set a material whose limit stresses are not defined (for example glass), the entry 
is highlighted in red. It is possible, however, to define the limit stresses by ticking the check 
box Manually in column D and entering user-defined specifications. When you have defined 
the allowable stresses in the columns E to G, the red color of the table row will disappear. 

The import of materials from the library is described on page 14. 
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Safety Factor γM 

This factor describes the safety factor used to calculate the design values of the material 
stiffnesses. Therefore M is indicated. By using the factor γM, the characteristic value of the 
yield strength fyk is reduced for the determination of the limit stresses according to 
Equation 2.1 or Equation 2.2. 

Thus, the factor γM is considered twice for the design if the calculation is carried out accord-
ing to the second-order or the large deformation analysis: On the one hand, for example 
according to DIN 18800 part 2, el. (116), you must consider the influence of deformations 
by a stiffness that is reduced about 10 % when determining internal forces. On the other 
hand, additionally, you must reduce the design values of stiffnesses by the partial safety 
factor γM when you design the ultimate limit state. 

Yield Strength fyk 

The yield strength describes the limit to which the material can be strained without plastic 
deformation. The characteristic values of several steel grades can be found for example in 
DIN 18800 part 1, section 4 or EC 3, section 3. 

Limit Stresses 
The limit stresses for materials from the general material library are preset automatically. 
Those entries provide no access for modifications. 

In case you want to modify the limit stresses, you can use the [Edit Material] button to open 
the Edit Material dialog box where you can change the material properties (see Figure 2.6, 
page 15). You can also use the check box Manually in column D. 

Manually 
If the check box is ticked, you can define the limit stresses in the subsequent columns 
manually. Materials that have been modified are highlighted in blue and marked by an 
asterisk in the column Material Description. 

Limit σx 
The limit normal stress as the allowable stress for stresses due to bending moments and 
membrane forces is determined, for example according to DIN 18800 part 1, el. (746), by 
the characteristic value of the yield strength, reduced by the partial safety factor γM. 

M

yk
d,R,x

f

γ
=σ  

Equation 2.1 

Limit τ 
The limit shear stress indicates the allowable shear stress due to shear and torsion. For 
example according to DIN 18800 part 1, el. (746), the partial safety factor γM is also 
considered in the equation for the determination of limit shear stress. 

3

f

M

yk
d,R

⋅γ
=τ  

Equation 2.2 

Limit σeqv 
The limit equivalent stress represents the allowable equivalent stress for the simultaneous 
effect of several stresses. According to DIN 18800 part 1, el. (746), it is determined by 
Equation 2.1. 
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Limit σeqv,m 
The limit membrane equivalent stress describes the allowable equivalent stress due to 
membrane stresses. It is determined according to Equation 2.1. 

Yield strength depending on thickness of structural components 
For some materials, there is a relation between the characteristic yield strength fyk and the 
thickness t of the relevant structural component. The Max. Structural Thickness of the re-
spective ranges with the corresponding yield strength is indicated in the Material Properties 
section of table 1.2. 

The yield strengths of structural thicknesses are defined in the standards, for example DIN 
18800 part 1, table 1. To check and adjust, if necessary, the structural thicknesses and as-
signed stresses, use the [Edit Material] button (see Figure 2.6, page 15). 

Material Library 
A number of materials is stored in the library that you can access by using the button below 
column A. The following dialog box opens which you already know from RFEM. 

 
Figure 2.5: Dialog box Material Library 

In the Filter Choice section, Steel is preset as material category. You can select a material 
from the list Material to Select on the right and check the corresponding parameters in the 
lower part of the dialog box. To transfer the material to table 1.2, click [OK], [↵] or double-
click the material itself. 

Chapter 5.3 in the RFEM manual describes in detail how materials can be filtered, added or 
rearranged. 
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When you select another material category than Steel, be aware that you can design only 
materials whose stress concept is based on the comparison of existing normal, shear and 
equivalent stresses with the respective allowable stresses. Under these conditions, it would 
be possible to design, for example, structural components made of aluminum or stainless 
steel. 

When you import a material whose limit stresses (for example glass) are not defined, the 
entries of the corresponding table row in table 1.2 are highlighted in red. It is possible, 
however, to define the limit stresses of this material by ticking the check box Manually in 
column D and entering user-defined specifications. The red color of the entries disappears 
as soon as you have entered the allowable stresses into column E to H. Please note that 
some stress designs, for example for glass surfaces, can only be carried out to some extent. 
In such a case, the use of the add-on module RF-GLASS is recommended. 

Edit Material 
The yield strengths and limit stresses of the currently selected material can be adjusted by 
clicking the button below column A. It is also shown on the left. The following dialog box 
appears: 

 
Figure 2.6: Dialog box Edit Material 

The Safety Factor γM determines how the characteristic values of the yield strength fyk indi-
cated in column C are reduced. The determined limit stresses (cf. Equation 2.1 and Equation 
2.2, page 13) are listed in column D to G. 

In the dialog section Yield Strengths and Limit Stresses Subject to Component Thicknesses, 
you can change the ranges of the component Thickness t. The number of ranges is preset in 
accordance with the standard, but it can be adjusted in the input field Number of Ranges 
below the table. In addition, you can modify the range limits by manual data input in col-
umn B. Column A will be adjusted automatically. For each range, you must assign a particu-
lar Yield Strength fyk. 

To define the limit stresses individually, tick the check box User-defined, Independent Defi-
nition of Limit Stresses. Then you can access column D to G to enter user-defined data. 

Materials that have been modified are marked by an asterisk in table 1.2. 
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2.1.3 Surfaces 

In this table, the surfaces that should be designed are listed. The material numbers already 
assigned in RFEM are preset (see description of previous table 1.2 Materials). Additionally, it 
is possible to define optimization parameters. 

 
Figure 2.7: Table 1.3 Surfaces 

Thickness 
Type 
When you open the table, the thickness types of the surfaces used in RFEM are preset to-
gether with the assigned material numbers. 

The surface thickness in the add-on module is restricted to the RFEM thickness types Con-
stant, Variable and Membrane isotropic. The design of other thickness types like orthotropic 
surfaces is currently not possible. But if you want to design such a surface, you can use the 
table 1.3 to change the thickness type to Constant: Place the pointer into the corresponding 
table row and click the button [ ] or use the function key [F7] to access the selection list. 
Then the design will be carried out with the RFEM internal forces as a surface with constant 
thickness and isotropic properties. 

d 
The thicknesses already defined in RFEM are preset but can be modified in column C. If you 
click in an input field, you can enter the new thickness manually or adjust it by using the 
spin buttons. 

Please note that the internal forces won't be redetermined automatically after optimizing 
parameters or modifying surface thicknesses. As a result of modified thicknesses, internal 
forces may vary considerably because of the changed stiffnesses in the structural system. 
Therefore, after the first design, it is recommended to adjust the thicknesses also in RFEM. 
Then you can design the surfaces again with the RF-STEEL Surfaces add-on module. 
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Max Stress Ratio 
This column will be displayed as soon as a design has been carried out. It is intended to be 
a decision support for the optimization process. By means of the displayed ratios and co-
lored relation scales, you can see which surfaces are hardly utilized and thus oversized, or 
extremely stressed and thus undersized. 

Optimize 
For each surface, you can carry out an optimization analysis. By using the RFEM internal 
forces, the program determines the surface thickness that comes as close as possible to the 
maximum stress ratio. 

To optimize a particular surface, tick its corresponding check box in column D. The follow-
ing dialog box appears. 

 
Figure 2.8: Dialog box Optimization Parameters 

This dialog box is described in chapter 6.2.1 on page 84. There, you find further recom-
mendations concerning the optimization process. 

Remark 
This column shows remarks in the form of footers that are described in detail below the 
surface list. 

If the display indicates remark 1) Surface cannot be designed because it is of type 
'Orthotropic', you can set the thickness type to 'Constant' to experiment, if required. Click in 
the corresponding input field of column B and use the button [ ] to open the selection list. 

Area 
This column gives information about the area of each surface. 

Weight 
This column displays the masses of the surfaces that you want to design. 

Comment 
The final column allows for user-defined comments, for example to document surface mod-
ifications. 
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2.1.4 Serviceability Data 

The last input table provides setting options for the serviceability limit state design. It is only 
available if you have set the relevant entries in the Serviceability Limit State tab of table 1.1 
(see chapter 2.1.1.2, page 11). 

 
Figure 2.9: Table 1.4 Serviceability Data 

List of Surfaces 
In this column, you enter the numbers of the surfaces that you want to design. You can al-
so use the [Pick] function to select the surfaces graphically in the RFEM work window. The 
respective reference lengths will be entered automatically in column C. 

In case several surfaces are entered in one input field, they should have the same geome-
trical conditions. The reference length L is preset as the maximum length of all boundary 
lines included in these surfaces. 

Reference Length 
Column C contains the values of the longest boundary lines in the respective surfaces. Here, 
the program refers to the lengths of single lines, continuous lines are not considered. 

To adjust a reference length, tick the Manual check box. Then you can access the input field 
for L where you can enter the value manually. You can also click the button [ ] to select it 
from the list or use the [...] function to determine it graphically in the RFEM work window. 
Manual corrections may be required, for example for surfaces that are placed within other 
surfaces. 

 
Figure 2.10: Dialog box to determine boundary points graphically 
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Cantilever 
To apply limit deformations correctly, it is also important to know if the surface is sup-
ported on all sides or if it is a cantilevered surface. 

In column D, you can determine the surface to be a cantilever in order to apply other servi-
ceability limit values. They can be checked and, if necessary, also adjusted in the Serviceabil-
ity tab of the Details dialog box (see Figure 2.12, page 25). 

2.2 Calculation 
The stress analysis is carried out by using the internal forces determined in RFEM. Before 
you start the calculation by clicking the [Calculation] button, it is recommended to check 
the design details. To open the corresponding dialog box, use the [Details] button. Details 
on this dialog box can be found in chapter 2.2.1.2 on page 25. 

2.2.1 Calculation Details 
2.2.1.1 Stresses 

Tables 2.1 to 2.5 display the following stresses by default: 

• Shear stresses τmax 

• Principal stresses σ in direction of principal axes on the surface's top and bottom side 

• Membrane stresses σm in direction of the principal axes 

• Equivalent stress σeqv 

• Membrane equivalent stress σeqv,m 

The display of stresses and stress components can be adjusted in the Stresses tab of the De-
tails dialog box. 

 
Figure 2.11: Dialog box Details, tab Stresses 

The stresses listed in the dialog section Stresses to Calculate are described in detail in the 
following table. 
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σx,+ 

Stress in direction of the local x-axis on the positive side of the surface (that 
means the side in direction of the positive surface axis z) 

2
xx

,x
d

m6
d
n ⋅

+=σ +  with  d: thickness of surface 

σy,+ 
Stress in direction of the local y-axis on the positive side of the surface 

2
yy

,y
d

m6

d

n ⋅
+=σ +

 

σxy,+ 
Torsional stress on the positive side of the surface 

2
xyxy

,xy
d

m6

d

n ⋅
+=σ +

 

σx,− 
Stress in direction of the x-axis on the negative side of the surface 

2
xx

,x
d

m6
d
n ⋅

−=σ −
 

σy,− 
Stress in direction of the y-axis on the negative side of the surface 

2
yy

,y
d

m6

d

n ⋅
−=σ −

 

σxy,− 
Torsional stress on the negative side of the surface 

2
xyxy

,xy
d

m6

d

n ⋅
−=σ −

 

σx,m 
Membrane stress due to axial force nx 

d
nx

m,x =σ
 

σy,m 
Membrane stress due to axial force ny 

d

ny
m,y =σ  

σxy,m 
Membrane stress due to shear flow nxy 

d

nxy
m,xy =σ  

σx,b 

Stress due to bending moment mx 

2
x

b,x
d

m6 ⋅
=σ  

σy,b 
Stress due to bending moment my 

2
y

b,y
d

m6 ⋅
=σ

 

τx 
Shear stress orthogonal to the surface in direction of the x-axis 

d2
v3 x

⋅
⋅

 

τy 
Shear stress orthogonal to the surface in direction of the y-axis 

d2

v3 y

⋅

⋅

 

τmax 
Maximum shear stress perpendicular to the surface 

2
y

2
xmax τ+τ=τ
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σ1,+ 

Stress in direction of the principal axis 1 on the positive side of the surface 
(that means the side in direction of the positive surface axis z) 

⎟
⎠
⎞

⎜
⎝
⎛ σ⋅+σ−σ+σ+σ=σ ++++++

2
,xy

2
,y,x,y,x,1 4)(

2
1

 

σ2,+ 
Stress in direction of the principal axis 2 on the positive side of the surface 

⎟
⎠
⎞

⎜
⎝
⎛ σ⋅+σ−σ−σ+σ=σ ++++++

2
,xy

2
,y,x,y,x,2 4)(

2
1

 

α+ 

Angle between local axis x (or y) and principal axis 1 (or 2) for stresses on the 
positive side of the surface 

⎟
⎟

⎠

⎞

⎜
⎜

⎝

⎛

⎟
⎟
⎠

⎞
⎜
⎜
⎝

⎛

σ−σ

σ⋅
=α

++

+
+

,y,x

,xy2
arctan

2
1

 

σ1,− 
Stress in direction of the principal axis 1 on the negative side of the surface 

⎟
⎠
⎞

⎜
⎝
⎛ σ⋅+σ−σ+σ+σ=σ −−−−−−

2
,xy

2
,y,x,y,x,1 4)(

2
1

 

σ2,− 
Stress in direction of the principal axis 2 on the negative side of the surface 

⎟
⎠
⎞

⎜
⎝
⎛ σ⋅+σ−σ−σ+σ=σ −−−−−−

2
,xy

2
,y,x,y,x,2 4)(

2
1

 

α − 

Angle between local axis x (or y) and principal axis 1 (or 2) for stresses on the 
negative side of the surface 

⎟
⎟

⎠

⎞

⎜
⎜

⎝

⎛

⎟
⎟
⎠

⎞
⎜
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⎝

⎛

σ−σ

σ⋅
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+
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σ1,m 
Membrane stress due to axial force n1 

d
n1

m,1 =σ
  with  d: thickness of surface 

σ2,m 
Membrane stress due to axial force n2 

d
n2

m,2 =σ
 

αm 

Angle between axis x and principal axis 1 (for axial force n1) 

⎥
⎥
⎦

⎤

⎢
⎢
⎣

⎡

⎟
⎟
⎠

⎞
⎜
⎜
⎝

⎛

−

⋅

yx

xy

nn

n2
arctan

2
1

 

σeqv Maximum equivalent stress as maximum of σeqv,+ and σeqv,− (see below) 

σeqv,+ 
Equivalent stress on the positive side of the surface (that means the side in 
direction of the positive surface axis z) according to selected stress hypothesis 
(see Table 2.2 to Table 2.5) 

σeqv,− 
Equivalent stress on the positive or negative side of the surface according to 
selected stress hypothesis (see Table 2.2 to Table 2.5) 

σeqv,m Membrane equivalent stress according to selected stress hypothesis 
(see Table 2.2 to Table 2.5) 

Table 2.1: Stresses 
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Shear Stresses 
To determine the Transversal Shear Stresses in the surfaces' neutral axes, select one of the 
following three methods (see Figure 2.11, page 19). 

Kirchhoff 

d
v

5,1 x
x ⋅=τ  

d

v
5,1 y

y ⋅=τ  

Equation 2.3 

Mindlin 

d
v

0,1 x
x ⋅=τ  

d

v
0,1 y

y ⋅=τ  

Equation 2.4 

User-defined 
You can specify a Factor that is used by the program to determine the shear stresses τx and 
τy in terms of Equation 2.3 or Equation 2.4. 

Equivalent Stresses 
The equivalent stresses from the individual stress components can be determined according 
to four different approaches (see Figure 2.11, page 19). 

Von Mises, Huber, Hencky 
This stress hypothesis is also known as Shape Modification Hypothesis or "equivalent stress 
according to VON MISES". It is assumed that the material fails as soon as the shape modifying 
energy exceeds a certain limit. This shape modification energy represents the kind of energy 
that causes distortion or deformation of the element. 

The equivalent stress according to the shape modification hypothesis is the most well-
known and frequently used equivalent stress hypothesis. It is the appropriate method for all 
materials that are not brittle. Therefore, it is widely used in steel building construction. 

However, the hypothesis is not applicable for hydrostatic stress conditions with similar prin-
cipal stresses in all directions, as the equivalent stress is zero in such cases. 

The equivalent stresses according to VON MISES for the plane stress conditions have the fol-
lowing meanings: 

σeqv,+ 

Equivalent stress on the positive side of the surface (that means the side in 
direction of the positive surface axis z) 

2
,xy,y,x

2
,y

2
,x,eqv 3 ++++++ σ⋅+σ⋅σ−σ+σ=σ  

σeqv,− 
Equivalent stress on the negative side of the surface 

2
,xy,y,x

2
,y

2
,x,eqv 3 −−−−−− σ⋅+σ⋅σ−σ+σ=σ  
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σeqv,m 

Membrane equivalent stress as the maximum absolute value of 

2
m,xy

2
m,ym,xm,ym,x

m,eqv 22
σ+⎟⎟

⎠

⎞
⎜⎜
⎝

⎛ σ−σ
+

σ+σ
=σ  or 

2
m,xy

2
m,ym,xm,ym,x

m,eqv 22
σ+⎟⎟

⎠

⎞
⎜⎜
⎝

⎛ σ−σ
−

σ+σ
=σ  or 

2
m,xy

2
m,ym,xm,eqv 4)( σ⋅+σ−σ=σ  

where 

d
nx

m,x =σ  

d

ny
m,y =σ   with  d: thickness of surface 

d

nxy
m,xy =σ  

Table 2.2: Equivalent stresses according to VON MISES, HUBER, HENCKY 

Tresca, Coulomb, Mohr 
In the Maximum Shear Stress Theory, which is also known as "equivalent stress according to 
TRESCA", it is assumed that failure is caused by the maximum shear stress. 

As this hypothesis is especially applicable for brittle materials, it is frequently used in me-
chanical engineering. 

These equivalent stresses are determined according to the following equations: 

σeqv,+ 

Equivalent stress on the positive side of the surface (that means the side in 
direction of the positive surface axis z) 

( ) 2
,xy

2
,y,x,eqv 4 ++++ σ⋅+σ−σ=σ  

σeqv,− 
Equivalent stress on the negative side of the surface 

( ) 2
,xy

2
,y,x,eqv 4 −−−− σ⋅+σ−σ=σ  

σeqv,m 

Membrane equivalent stress 

( ) 2
m,xy

2
m,ym,xm,eqv 4 σ⋅+σ−σ=σ  

Table 2.3: Equivalent stresses according to TRESCA, COULOMB, MOHR 
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Rankine, Lamé 
This equivalent stress hypothesis is also known as Maximum Principal Stress Criterion  or as 
"equivalent stress according to RANKINE". It is assumed that failure is caused by the maximum 
principal stress. 

The equivalent stresses are determined according to the following equations: 

σeqv,+ 

Maximum absolute value of equivalent stress on the positive side of the 
surface 

( ) ( ) 2
,xy

2
,y,x,y,x,eqv 4

2
1

2
1

++++++ σ⋅+σ−σ±σ+σ=σ  

σeqv,− 

Maximum absolute value of equivalent stress on the negative side of the 
surface 

( ) ( ) 2
,xy

2
,y,x,y,x,eqv 4

2
1

2
1

−−−−−− σ⋅+σ−σ±σ+σ=σ  

σeqv,m 

Maximum absolute value of membrane equivalent stress 

( ) ( ) 2
m,xy

2
m,ym,xm,ym,xm,eqv 4

2
1

2
1

σ⋅+σ−σ±σ+σ=σ  

Table 2.4: Equivalent stresses according to RANKINE, LAMÉ 

Bach, Navier, St. Venant, Pocelet 
For the Principal Strain Criterion, also known as the "equivalent stress according to BACH", it 
is assumed that the failure occurs in direction of the maximum strain. This approach is simi-
lar to the stress determination according to RANKINE described above. Here, the principal 
strain is used instead of the principal stress. 

These equivalent stresses are determined as follows: 

σeqv,+ 

Maximum absolute value of equivalent stress on the positive side of the 
surface 

( ) ( ) 2
,xy

2
,y,x,y,x,eqv 4

2
1

2
1

++++++ σ⋅+σ−σ
μ+

±σ+σ
μ−

=σ  

with μ : Poisson's ratio of material 

σeqv,− 

Maximum absolute value of equivalent stress on the negative side of the 
surface 

( ) ( ) 2
,xy

2
,y,x,y,x,eqv 4

2
1

2
1

−−−−−− σ⋅+σ−σ
μ+

±σ+σ
μ−

=σ  

σeqv,m 

Maximum absolute value of membrane equivalent stress 

( ) ( ) 2
m,xy

2
m,ym,xm,ym,xm,eqv 4

2
1

2
1

σ⋅+σ−σ
μ+

±σ+σ
μ−

=σ  

Table 2.5: Equivalent stresses according to BACH, NAVIER, ST. VENANT, POCELET 
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2.2.1.2 Serviceability 

 
Figure 2.12: Dialog box Details, tab Serviceability 

The six input fields are used to manage the Serviceability Limits of the allowable deflections. 
It is possible to enter specific settings for the different action combinations (Characteristic, 
Frequent, Quasi-permanent) as well as for both- and one-sided supported surfaces. 

The classification of action combinations is determined in the Serviceability Limit State tab 
of table 1.1 General Data (see chapter 2.1.1.2, page 11). The reference lengths L are defined 
for each surface in table 1.4 Serviceability Data (see chapter 2.1.4, page 18). 
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2.2.1.3 Options 

 
Figure 2.13: Dialog box Details, tab Options 

Analysis Method for Load Combinations 
To some extent it is possible to influence the method of stress determination for the design 
of load combinations. The Mixed Method is preset by default: Before the design is carried 
out, the program checks if the Enumeration Method is more effective than the Envelope 
Method or vice versa. 

Enumeration Method 
If this method is selected, the module evaluates the internal forces from RFEM line by line to 
superimpose them appropriately. This is the approach that comprehends all combination 
possibilities accurately. 

The disadvantage of the enumeration method is that the number of combinations for the 
analysis is growing exponentially with the number of load cases when processing the data 
line by line. The relation is the following: 

 Number of combination possibilities n2=  

   with    n = number of load cases 

The more load cases the combination contains, the more time is required for the stress 
analysis. In the results, however, all possible combinations are included. 

Envelope Method 
If this method is selected, the module considers only the extreme values of the basic 
stresses of each load case to combine them subsequently. In this way, this approach may 
possibly not comprehend the most unfavorable combinations that would be included in a 
line by line process. However, the computing time for a relatively large number of load cas-
es in a load combination is quite acceptable when this kind of method is used. 
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As only the maximum values are analyzed, the stresses designed according to this method 
may be incorrect. In particular structures with load cases whose effective directions tend to 
be orthogonal must be handled carefully. In such cases, a calculation according to the 
enumeration method is recommended to check the results. 

Mixed Method 
If this method is selected, the module checks how many combination possibilities exist on 
the basis of the load cases contained within (cf. enumeration method) before the actual de-
sign will be carried out. For example, if a load combination contains seven load cases, 

12827 =  

combination possibilities must be analyzed. As this number is higher than the preset num-
ber of 100 possibilities, the subsequent design will be carried out according to the envelope 
method. 

The choice of the analysis method can be influenced by means of the input field. This field 
defines the upper limit of the combination possibilities for the design according to the ac-
curate enumeration method. 

Thus, the Mixed Method represents a compromise between result accuracy and design ve-
locity, and therefore it becomes the appropriate method for most of the application cases. 

Results 
By default, stresses and displacements are displayed in all FE Mesh Points. As an alternative, 
the results output is available in the user-defined Grid Points managed as surface properties 
in RFEM (see RFEM manual, chapter 9.9). 

Especially for small surfaces, the default mesh size of 500 mm for the results grid may pro-
duce only few grid points or even only one grid point in the grid origin. In these cases, the 
maximum values are often not considered in the output tables because the results grid is 
too coarse. The spacing of grid points in RFEM should be adjusted to the surfaces' dimen-
sions in order to generate more grid points. 

Optimization of Surface Thicknesses 
If the optimization process does not gear towards the maximum possible stress ratio of 100 
%, you can specify a different limit value in this input field. 

Display Result Tables 
This dialog section controls the display of the results tables. You can select several output 
tables for stresses, displacements and parts lists which can be switched on and off by tick-
ing the corresponding check boxes. 

The results tables are described in detail in chapter 2.3. 
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2.2.2 Start Calculation 

You can start the calculation out of each of the three or four input tables by clicking the 
[Calculation] button. 

RF-STEEL Surfaces searches for the results of the load cases, load groups and load combina-
tions that should be designed. If they cannot be found, the program starts the RFEM calcu-
lation to determine the design relevant internal forces. In this determination process, the 
calculation parameters preset in RFEM are applied. 

You can also start the calculation for RF-STEEL Surfaces out of the RFEM user interface. The 
add-on modules are listed in the dialog box To Calculate like load cases or load groups. To 
open the dialog box in RFEM, 

select To Calculate on the Calculate menu. 

 
Figure 2.14: RFEM dialog box To Calculate 

If the design cases of RF-STEEL are missing in the Not Calculated list, tick the check box 
Show Additional Modules. 

To transfer selected RF-STEEL cases to the list on the right, use the button [ ]. Start the cal-
culation by using the [Calculate] button. 

To calculate an RF-STEEL case directly, use the list in the RFEM toolbar. Select the relevant 
design case in the toolbar list and click the button [Results on/off]. 

 
Figure 2.15: Direct calculation of an RF-STEEL design case in RFEM 
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2.3 Results 
Table 2.1 Stresses by Load Case is displayed immediately after the calculation. All stresses 
are shown in the results tables 2.1 to 2.5, sorted by different criteria. 

Table 2.6 Stress Ranges lists the maximum differences between the stresses (for example for 
fatigue designs). Table 3.1 Displacements contains the maximum deformations in relation 
to the allowable limit values. 

The final table 4.1 Parts List offers an overview about the required amount of steel. 

In the Options tab of the Details dialog box, you can select the results tables that you want 
to display in particular (see Figure 2.13, page 26). 

To access the results tables, use the RF-STEEL navigator. You can also use the two buttons 
shown on the left or the function keys [F2] and [F3] to select the previous or subsequent 
table. 

By default, the result values are displayed in the FE mesh points. As an alternative, the re-
sults output is available in the user-defined grid points. The corresponding setting can be 
defined in the Options tab of the Details dialog box. 

Click [OK] to save the results and quit the add-on module RF-STEEL Surfaces. 

In the following, the different results tables are described in sequence. Evaluating and 
checking results is described in chapter 4 Results Evaluation. 

2.3.1 Stresses by Load Case 

 
Figure 2.16: Table 2.1 Stresses by Load Case 

The table shows a summary of results for each load case, load group and/or load combina-
tion that has been selected for design in the Ultimate Limit State tab of table 1.1 General 
Data. The relevant load cases, load groups and/or load combinations are indicated in the 
first column, specifying the arrangement of the results output. 
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Surface No. 
The column lists the numbers of surfaces for which maximum stress components or ratios 
have been determined. The output is displayed by load cases. 

FE Mesh Point No. / Grid Point No. 
The column displays the numbers of grid or FE mesh points in which the ratios' maximum 
values occur. The grid points represent an option to display the results in user-defined, reg-
ular spacings, completely independent from the FE mesh. The number of grid points and 
their arrangement is managed in the Grid tab of the RFEM dialog box Edit Surface.  

By selection in the Options tab of the Details dialog box, you can decide if you want to con-
sider either FE mesh nodes or user-defined grid points for the evaluation (cf. Figure 2.13, 
page 26). When data has been modified, a query appears before the results will be recalcu-
lated. 

Point Coordinates X/Y/Z 
The three columns contain the coordinates of the governing FE mesh or grid points. They 
refer to the global coordinate system XYZ. 

Stress - Symbol 
The following stresses are displayed by default: 

• shear stresses τmax 

• principal stresses σ in direction of the principal axes on the surface's top and bottom 
side 

• membrane stresses σm in direction of the principal axes 

• equivalent stress σeqv 

• membrane equivalent stress σeqv,m 

Each stress type or component has its own symbol. The indices of the normal stresses σ, the 
shear stresses τ and the equivalent stresses σeqv have the following meanings: 

 
 

 
Table 2.6: Symbols of stresses 

The display of stresses and stress components can be adjusted in the Stresses tab of the De-
tails dialog box (see Figure 2.11, page 19). To open the dialog box, use the button shown 
on the left (at the bottom of the list below column E). 

The definition of positive and negative surface sides corresponds to the conventions given 
in RFEM: The positive surface side is always defined in direction of the positive local axis z of 
each surface, regardless of the orientation of the global axis Z. 

Symbol Meaning 

x Direction of the local surface axis x 

y Direction of the local surface axis y 

1 Direction of the principal axis 1 

2 Direction of the principal axis 2 

+ Positive surface side (side in direction of the positive local surface axis z) 

– Negative surface side (side in the opposite direction of the positive surface axis z)

m Stress due to membrane force (axial force) 

b Stress due to bending moment 
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Context menu of surface 

 

To display the local surface axes, use the Display navigator in RFEM or the context menu of 
the corresponding surface. 

 
Figure 2.17: Activating the surface axis systems in the Display navigator of RFEM 

Stress - Existing 
This column displays the extreme values of the existing stresses analyzed according to the 
equations described in Table 2.1 (see page 20). 

For each stress type, the program calculates the maximum (positive) and minimum (nega-
tive) stress values to compare their results subsequently. The value that is higher than the 
other one will appear in column G. 

The equivalent stresses σeqv are determined according to the equivalent stress hypothesis 
specified in the Stresses tab of the Details dialog box (see Figure 2.11, page 19). Four ap-
proaches, that are described in detail in chapter 2.2.1.1 page 22, are available for selection: 

• shape modification hypothesis according to VON MISES, HUBER, HENCKY 

• maximum shear stress theory according to TRESCA, COULOMB, MOHR 

• maximum principal stress criterion according to RANKINE, LAMÉ 

• principal strain criterion according to BACH, NAVIER, ST. VENANT, PONCELET 

Stress - Limit 
This column shows the limit stresses of table 1.2 (see chapter 2.1.2, page 13). In particular, 
they are the following: 

• Limit normal stress σ as the allowable stress for actions due to bending moments and 
membrane forces 

• Limit shear stress τ as the allowable shear stress due to shear and torsion 

• Limit equivalent stress σeqv as the allowable equivalent stress for the simultaneous ef-
fect of several stresses 

• Limit membrane equivalent stress σeqv,m as the allowable equivalent stress due to 
membrane stresses 



2  RF-STEEL Surfaces 

 32 Program RF-STEEL © 2010 Dlubal Engineering Software 

 

Stress Ratio 
For each stress component, RF-STEEL Surfaces determines the quotient from the existing 
and the limit stress, as shown for example in DIN 18800 part 1, el. (747). The stress ratio of 
the surface on the respective FE mesh or grid point is displayed for every selected stress 
type. If the relevant limit stress is not exceeded, the ratio is less than or equal to 1 and the 
stress design was carried out successfully. 

Thus, column I allows for a quick evaluation of efficiency. 

1
d,R
≤

σ
σ

 

Equation 2.5: Design condition for normal stresses 

1
d,R
≤

τ
τ

 

Equation 2.6: Design condition for shear stresses 

1
d,R

v ≤
σ
σ

 

Equation 2.7: Design condition for equivalent and membrane equivalent stresses 

2.3.2 Stresses by Material 

 
Figure 2.18: Table 2.2 Stresses by Material 

The maximum stress ratios listed in this table are sorted by materials. The materials are indi-
cated in the first column, specifying the arrangement of the results output. 

The different columns are described in detail in the previous chapter 2.3.1. 
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2.3.3 Stresses by Surface 

 
Figure 2.19: Table 2.3 Stresses by Surface 

This results table contains the maximum stresses and stress ratios that are available for each 
designed surface. The results are listed by surfaces. In addition, information concerning ma-
terial and thickness is displayed. 

2.3.4 Stresses by Line 

 
Figure 2.20: Table 2.4 Stresses by Line 
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Filter function 

The maximum stresses are displayed for all lines that are available in the designed surfaces. 
The results are listed by line numbers. 

2.3.5 Stresses in All Points 

 
Figure 2.21: Table 2.5 Stresses in All Points 

This results table is inactive by default because the program must manage a considerable 
amount of data when complex structures are analyzed. However, for a specific numerical 
evaluation, it is possible to activate the table by selecting the corresponding option in the 
Options tab of the Details dialog box (see Figure 2.13, page 26). 

The table shows the stresses and stress ratios for each FE mesh or grid point that is availa-
ble in the designed surfaces. By selection in the Options tab of the Details dialog box, you 
can decide if you want to consider either FE mesh nodes or user-defined grid points for the 
evaluation (cf. Figure 2.13, page 26). When data has been modified, a query appears before 
the results will be recalculated. 

The display of stresses and stress components can be adjusted in the Stresses tab of the De-
tails dialog box (see Figure 2.11, page 19). To open the dialog box, use the button shown 
on the left at the bottom of the list. 

The different columns are described in detail in chapter 2.3.1, page 30. 

The table results can be sorted according to surface, line and node numbers as well as load 
cases if you want to evaluate the results specifically. Use the lists below the corresponding 
columns to select the data. You can also use the [Pick] function to select structural objects 
graphically. 
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2.3.6 Stress Ranges 

 
Figure 2.22: Table 2.6 Stress Ranges 

This results table is inactive by default. However, to activate the table, tick the correspond-
ing check box in the Options tab of the Details dialog box (see Figure 2.13, page 26). 

The stress ranges of the stress intensities are required for fatigue designs when analyzing 
the fatigue behavior. The table displays the stress differences for each FE mesh or grid point 
of the designed surfaces. By selection in the Options tab of the Details dialog box, you can 
decide if you want to consider either FE mesh nodes or user-defined grid points for the 
evaluation (cf. Figure 2.13, page 26). 

The display of stress types can be defined in the Stresses tab of the Details dialog box (see 
Figure 2.11, page 19). To open the dialog box, use the button shown on the left at the bot-
tom of the list. 

The table results can be filtered according to surface, line and node numbers. Use the lists 
below the corresponding columns to select the data. You can also use the [Pick] function 
for the graphical selection. 

Details on columns A to G can be found in chapter 2.3.1 on page 30. 

Loading 
Columns H and J show the relevant load cases, load groups or load combinations that bear 
the maximum and minimum stress components. In these two columns, all actions that have 
been set for the ultimate limit state design are considered. 

Maximum / Minimum 
Column I lists the maximum stress values that are available for each stress type. Column K 
lists the minimum stress values. The Maximum is represented by the positive extreme values, 
the Minimum is represented by the negative ones.  
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Range 
The values displayed in this column represent the range of stresses that results from the re-
levant extreme values in column I and K. 

2.3.7 Displacements 

 
Figure 2.23: Table 3.1 Displacements 

The deformation analyses are only displayed when you have selected at least one action for 
the design in the Serviceability Limit State tab of table 1.1 General Data (see chapter 
2.1.1.2, page 11). Furthermore, it is necessary to have defined surface reference lengths for 
the limit deformations in table 1.4 Serviceability Data (see chapter 2.1.4, page 18). 

The results table displays the maximum displacements due to the serviceability load cases or 
combinations. The results are listed by surfaces. 

In addition, the table shows the deformations and stress ratios for each FE mesh or grid 
point that is available in the designed surfaces. The settings in the Options tab of the De-
tails dialog box (see Figure 2.13, page 26) determine if the table displays nodes of the FE 
mesh or user-defined grid points. 

Details on columns A to D can be found in chapter 2.3.1 on page 30. 

Loading 
All actions that have been selected for the deformation analysis are listed by surfaces in col-
umn E. In this way, you can evaluate specifically the maximum deformation for each single 
load case or load combination. 

Combination 
This column shows the action combinations  that have been assigned in the Serviceability 
Limit State tab of table 1.1 General Data (see chapter 2.1.1.2, page 11). 

• Characteristic (CH) 

• Frequent (FR) 

• Quasi-permanent (QP) 
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Context menu of surface 

Displacements - uz 
This column displays the governing deformations in direction of the local surface axes z. The 
maximum deformations uz refer to the non-deformed original structural system. 

To display the local surface axes, use the Display navigator in RFEM or the context menu of 
the corresponding surface (see Figure 2.17, page 31). 

Displacements - Limit uz 
Column H contains the limit deformations in direction of the z-axis of each surface. These 
deformations are determined by the reference lengths L of the boundary lines that have 
been defined in table 1.4 (see chapter 2.1.4, page 18) and the general serviceability limits 
specified in the Serviceability tab of the Details dialog box (see chapter 2.2.1.2, page 25). 

Ratio 
The final column shows the quotients determined from the existing displacement uz (col-
umn G) and the allowable displacement Limit uz (column H). If the limit deformations are 
not exceeded, the ratio is less than or equal to 1.00 and the serviceability limit state design 
was carried out successfully. 

Maximum and Minimum Displacement by Value / Ratio 
At the bottom of the table, a summary is displayed showing the extreme displacement val-
ues and stress ratios of all designed surfaces. The output is divided in maximum (positive) 
and minimum (negative) results. 

2.3.8 Parts List 

 
Figure 2.24: Table 4.1 Parts List 

Finally, RF-STEEL Surfaces provides a summary of all surfaces that are included in the design 
case. By default, the list contains only the designed surfaces. If you want to display a parts 
list with all surfaces of the structure, select the corresponding option in the Options tab of 
the Details dialog box (see Figure 2.13, page 26). 



2  RF-STEEL Surfaces 

 38 Program RF-STEEL © 2010 Dlubal Engineering Software 

Part No. 
Referring to the surface numbers, the program assigns part numbers to the surfaces. 

Material 
The surfaces are listed by materials. Each material is closed by the Sum of the values that 
are displayed in column D to G. 

Thickness 
Columns B and C show the Type of thickness as well as the thickness d. The entries refer to 
the input data in table 1.3 Surfaces. 

Area 
This column gives information about the area of each surface. 

Coating 
The surface area of a surface is determined from the top and bottom side of the surface. As 
steel surfaces are usually thin-walled, the lateral surfaces are not considered. 

Volume 
The volume of a surface is determined by the product of its thickness and area. If the sur-
face has a variable thickness, the program considers this property accordingly. 

Weight 
The final column displays the masses of each surface. The value is determined from the rele-
vant volume of the surface and the weight density of the material that is used. 

Sum 
At the bottom of the list, you find a summary showing the sums of the columns D to G. The 
results output in the Weight column gives information about the overall steel mass that is 
required. 
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3. RF-STEEL Members 
 

3.1 Input Data 
The data for the definition of design cases is entered in tables. 

When you have started RF-STEEL Members, a new window opens where a navigator is dis-
played on the left, managing all tables that can be selected currently. The pull-down list 
above the navigator contains the design cases already available (see chapter 6.1, page 82). 

If you open RF-STEEL Members in an RFEM structure for the first time, the module imports 
the following design relevant data automatically: 

• Members and sets of members 

• Load cases, groups and combinations 

• Materials 

• Cross-sections 

• Internal forces (in background, if calculated) 

To select a table, click the corresponding entry in the RF-STEEL navigator or page through 
the tables by using the buttons shown on the left. The function keys [F2] and [F3] can also 
be used to select the previous or subsequent table. 

To save the defined settings and quit the module, click [OK]. When you click [Cancel], you 
quit the module but without saving the data. 

3.1.1 General Data 

In table 1.1 General Data, you define the loads and members that you want to design. The 
design standard is specified in table 1.2, even though indirectly, because the material prop-
erties are related to the standard. 

 
Figure 3.1: Table 1.1 General Data 



3  RF-STEEL Members 

 40 Program RF-STEEL © 2010 Dlubal Engineering Software 

 
 

 

 
 

 

 

 

 

Design of 
The design can be carried out for Members as well as for Sets of Members. If you want to 
design only selected objects, clear the All check boxes. Then you can access the two input 
fields to enter the numbers of the relevant members or sets of members. The list of the pre-
set member numbers can be selected quickly by double click and overwritten by entering 
the data manually. 

To select the objects graphically in the RFEM work window, use the [Pick] button. 

 
Figure 3.2: Graphical selection in the model 

In case that you have not yet defined any sets of members in RFEM, you can create them in 
the RF-STEEL module by clicking the [New] button. The dialog box that you already know 
from RFEM appears where you can specify the data for a new set of members. 

By means of a set of members design, it is possible to design several selected members and 
determine the total maxima of the stresses and stress ratios of all members contained in the 
set of members. In such a case, table 2.2 Stresses by Set of Members and table 4.2 Parts List 
by Set of Members are displayed. 

Existing Load Cases / Load Groups and Load Combinations 
These two sections list all load cases, load groups and load combinations defined in RFEM 
that are relevant for the design. Use the button [ ] to transfer selected load cases or com-
binations to the list Selected for Design on the right. You can also double-click the entries. 
To transfer the complete list to the right, use the button [ ]. 

When load cases are marked by an asterisk (*) like load cases 6 and 7 in Figure 3.1, they 
cannot be calculated. This may be the case when no loads are defined or when the load 
case contains only imperfections. 

Selected for Design 
The column on the right lists the loads selected for the design. Use the button [ ] to re-
move selected load cases or combinations from the list. You can also double-click the en-
tries. With the button [ ], you can transfer the entire list to the left. 

The analysis of an enveloping Or load combination is often carried out more quickly than 
the global design of all created load cases and load groups. On the other hand, when ana-
lyzing the entire load combination, the influence of the contained loads is hardly transpar-
ent: RF-STEEL Members uses the max/min results of the RFEM table 3.5 Members - Internal 
Forces where the internal forces of the different load cases are superimposed accordingly. 
Therefore, when selecting load combinations, it is recommended to check the settings for 
the Method of Stress Calculation in the Details dialog box additionally (see chapter 3.2.2, 
page 50). 

Comment 
This input field allows for user-defined remarks, for example to describe the current design 
case. 
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3.1.2 Materials 
The table is subdivided into two parts. In the upper part, the materials used for the design 
are listed with the relevant limit stresses. In the Material Properties section below, the prop-
erties of the current material, i.e. the table row currently selected in the upper section, are 
displayed. 

The material properties required for the determination of internal forces in RFEM are de-
scribed in detail in chapter 5.3 of the RFEM manual. All design relevant material properties 
are stored in the global material library and are preset automatically but can be adjusted in 
the present table. 

To adjust the units and decimal places of material properties and stresses, select Units and 
Decimal Places in the module's Settings menu. 

 
Figure 3.3: Table 1.2 Materials 

Material Description 
The materials defined in RFEM are already preset. But it is possible to select another materi-
al by using the list: Place the pointer in a table row of column A, and then click the button 
[ ] or use the function key [F7]. The list shown on the left opens. When you have selected a 
new material, the design relevant properties are entered into the corresponding table row 
and are highlighted in blue. 

Only steel materials are available in the list. In principle, you can carry out the design with 
any material whose stress concept is based on the comparison of existing normal, shear and 
equivalent stresses with the respective allowable stresses. Therefore, it would be possible to 
design cross-sections made of aluminum or stainless steel. However, you must consider the 
corresponding standard specifications additionally. 

If you have set a material whose limit stresses are not defined (for example timber), the en-
try is highlighted in red. It is possible, however, to define the limit stresses by ticking the 
check box Manually in column D and entering specified data. When you have defined the 
allowable stresses in the columns E to G, the red color of the table row will disappear. 
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The import of materials from the library is described on page 14. 

Safety Factor γM 

This factor describes the safety factor used to calculate the design values of the material 
stiffnesses. Therefore M is indicated. By using the factor γM, the characteristic value of the 
yield strength fyk is reduced for the determination of the limit normal stress σR,d (see 
Equation 2.1) and the limit shear stress τR,d (Equation 2.2). 

Thus, the factor γM is considered twice for the design if the calculation is carried out accord-
ing to the second-order or the large deformation analysis: On the one hand, you must con-
sider, for example according to DIN 18800 part 2, el. (116), the influence of deformations 
by a stiffness that is reduced about 10 % when determining internal forces. On the other 
hand, additionally, you must reduce the design values of stiffnesses by the partial safety 
factor γM when you design the ultimate limit state. 

Yield Strength fyk 

The yield strength describes the limit to which the material can be strained without plastic 
deformation. The characteristic values of several steel grades can be found for example in 
DIN 18800 part 1, section 4 or EC 3, section 3. 

Limit Stresses 
The limit stresses for materials from the general material library are preset automatically. 
Those entries provide no access for modifications. 

In case you want to modify the limit stresses, you can use the [Edit Material] button to open 
the Edit Material dialog box where you can change the material properties (see Figure 2.6, 
page 15). You can also use the check box Manually in column D. 

Manually 
If the check box is ticked, you can define the limit stresses in the subsequent columns 
manually. Materials that have been modified are highlighted in blue and marked by an 
asterisk in the column Material Description. 

limit σx 
The limit normal stress represents the allowable stress for actions due to bending and 
membrane force. It is determined, for example according to DIN 18800 part 1, el. (746), by 
the characteristic value of the yield strength that is reduced by the partial safety factor γM. 

M

yk
d,R,x

f

γ
=σ  

Equation 3.1 

limit τ 
The limit shear stress indicates the allowable shear stress due to shear and torsion. For 
example according to DIN 18800 part 1, el. (746), the partial safety factor γM is also 
considered in the equation for the determination of limit shear stress. 

3

f

M

yk
d,R

⋅γ
=τ  

Equation 3.2 

limit σeqv 
The limit equivalent stress represents the allowable equivalent stress for the simultaneous 
effect of several stresses. According to DIN 18800 part 1, el. (746), it is determined by 
Equation 3.1. 
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Yield strength depending on thickness of structural components 
For some materials, there is a relation between the characteristic yield strength fyk and the 
thickness t of the relevant structural component. The Max. Structural Thickness of the re-
spective ranges with the corresponding yield strength is indicated in the Material Properties 
section of table 1.2. 

The yield strengths of structural thicknesses are defined in the standards, for example DIN 
18800 part 1, table 1. To check and adjust, if necessary, the structural thicknesses and as-
signed stresses, use the [Edit Material] button (see Figure 2.6, page 15). 

Material Library 
A number of materials is stored in the library that you can access by using the button below 
column A. The dialog box which you already know from RFEM opens (see Figure 2.5, page 
14). 

The import of materials from the library is described in chapter 2.1.2 on page 14. Chapter 
5.3 of the RFEM manual describes in detail how materials in the library can be filtered, add-
ed or rearranged. 

When you select another material category than Steel, be aware that you can design only 
materials whose stress concept is based on the comparison of existing normal, shear and 
equivalent stresses with the respective allowable stresses. Under these conditions, it would 
be possible to design, for example, structural components made of aluminum or stainless 
steel. 

When you import a material whose limit stresses (for example timber) are not defined, the 
entries of the corresponding table row in table 1.2 are highlighted in red. It is possible, 
however, to define the limit stresses of this material by ticking the check box Manually in 
column D and entering user-defined specifications. As soon as you have defined the allow-
able stresses in the columns E to G, the red color of the table row disappears. Please note 
that some stress designs, for example for timber cross-sections, can only be carried out to 
some extent. The corresponding standard criteria are implemented in the add-on module 
TIMBER Pro. 

Edit Material 
The yield strengths and limit stresses of the currently selected material can be adjusted by 
clicking the button below column A. It is also shown on the left. 

The Edit Material dialog box shown in Figure 2.6 and described on page 15 opens. The ma-
nual text describes how to adjust the partial safety factor, the characteristic values of the 
yield strength fyk or the yield strengths and limit stresses in relation to the component 
thickness as well as the ranges of the component thicknesses. 



3  RF-STEEL Members 

 44 Program RF-STEEL © 2010 Dlubal Engineering Software 

 
 

 

3.1.3 Cross-sections 

In this table, the cross-sections that should be designed are listed. The material numbers al-
ready assigned in RFEM are preset (see description of previous table 1.2 Materials). Addi-
tionally, it is possible to define optimization parameters. 

 
Figure 3.4: Table 1.3 Cross-sections 

Cross-section Description 
When you open the table, the thickness types of the cross-sections used in RFEM are preset 
together with the assigned material numbers. 

It is always possible to modify the preset cross-sections for the design. The description of a 
modified cross-section is highlighted in blue. 

If you want to modify a cross-section, you can enter the new cross-section description di-
rectly into the corresponding table row. As an alternative, you can select the relevant cross-
section from the library. The library can be opened by clicking the button [Import Cross-
section from Library], by placing the pointer into the corresponding table row to enable the 
[...] button or by using the function key [F7]. The library dialog box from RFEM appears with 
the selected cross-section table. 
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Figure 3.5: Dialog box of cross-section library Rolled cross-sections - I-Sections 

The selection of cross-sections from the library is described in details in chapter 5.13 of the 
RFEM manual. 

If the cross-sections in RF-STEEL are different from the ones used in RFEM, both cross-
sections are displayed in the graphic in the right part of the table. In such a case, the pro-
gram will carry out the stress designs for the cross-section selected in RF-STEEL with the in-
ternal forces from RFEM. 

Member with tapered cross-section 
For tapered members with different cross-sections at the member start and member end, 
the module displays both cross-section numbers, in accordance with the RFEM definition, in 
two table rows. RF-STEEL Members can design tapered members when both cross-sections 
have the same number of stress points. 

The normal stresses are determined from the moments of inertia and the centroidal dis-
tances of the stress points. If the start and the end cross-section of a tapered member have 
not the same number of stress points, the intermediate values cannot be interpolated. In 
such a case, RFEM applies the corresponding cross-section properties up to the middle of 
the member to facilitate the calculation and the rendering. In RF-STEEL, however, a design 
is not possible. Therefore, a warning appears before the calculation will be carried out. 

 
Figure 3.6: Warning in case of incompatible cross-sections 

To check the data, you can display the cross-section's stress points including numbering in 
the cross-section graphic (in the right part of the table). For more information on stress 
points, see chapter 3.3.1 on page 55. 
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IVU-sections 

To produce the same number of stress points for tapered members, you can, for example, 
model the taper's end cross-section as a copy of the cross-section start adjusting only the 
geometry parameters. If required, you define both cross-sections as parameterized 
("Welded") cross-sections. With the cross-section group I-Section Plus Lower Flange, the 
library provides cross-sections especially for tapers. 

Max. Design Ratio 
This column will be displayed as soon as a design has been carried out. It is intended to be 
a decision support for the optimization process. By means of the displayed ratios and co-
lored relation scales, you can see which cross-sections are hardly utilized and thus over-
sized, or extremely stressed and thus undersized. 

Optimize 
For each cross-section, you can carry out an optimization process. By using the RFEM inter-
nal forces, the module determines the cross-section within the respective cross-section table 
that comes as close as possible to a user-defined maximum ratio. This ratio is defined in the 
Details dialog box (see Figure 3.8, page 50). 

To optimize a particular cross-section, tick its corresponding check box in column C or D. 
Recommendations for the cross-section optimization can be found in chapter 6.2.2 on page 
85. 

Remark 
This column shows remarks in the form of footers that are described in detail below the 
cross-section list. 

If the display indicates remark 6) Incorrect cross-section data! Members of this cross-section 
will not be designed., you have defined an unknown cross-section, i.e. it is not available in 
the cross-section database. This may be the case for a user-defined or not yet calculated 
SHAPE cross-section. In such a case, define the required settings in RFEM, for example the 
Stress Points (see chapter 5.13 of the RFEM manual, section Create User-defined Cross-
sections). 

Cross-section graphic 
In the right part of table 1.3, the currently selected cross-section is displayed graphically. 
The buttons are reserved for the following functions: 

 

 

 
Table 3.1: Buttons of cross-section graphic 

Button Function 

 Opens the dialog box Info about cross-section with the cross-section properties.

 Displays or hides the dimensions of the cross-section. 

 Displays or hides the principal axes of the cross-section. 

 Displays or hides the stress points. 

 Displays or hides the numbering of stress points. 

 Resets the cross-section graphic. 
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3.2 Calculation 
The stress analysis is carried out by using the internal forces determined in RFEM. Before 
you start the calculation by clicking the [Calculation] button, it is recommended to check 
the design details. To open the corresponding dialog box, use the [Details] button. Details 
on this dialog box can be found in chapter 3.2.2 on page 50. 

3.2.1 Stresses and Ratio 
Tables 2.1 to 2.5 show the normal stresses σtotal, τtotal and σeqv by default. To display the in-
dividual stress components, use the buttons [Select Stresses to Show] and [Extended Stress 
Diagram]. 

Normal stresses 
The normal stresses σ have the following meanings: 

σN 

Stress due to axial force N 

A
N

=σ  

with A: cross-sectional area of cross-section 

σM-y 

Stress due to bending moment My 

z
yy,pl

y e
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M
⋅

⋅α
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with αpl,y: plastic form factor according to DIN 18800 part 1, el. (750) 
 Iy: moment of inertia related to principal axis y 
 ez: centroidal distance of the stress point in direction z 

σM-z 

Stress due to bending moment Mz 

y
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M
⋅
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with αpl,z: plastic form factor according to DIN 18800 part 1, el. (750) 
 Iz: moment of inertia related to principal axis z 
 ey: centroidal distance of the stress point in direction y 

σM 
Stress due to bending moments My and Mz 
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σtensile 
Tensile stress due to axial force N and bending moments My and Mz 
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σcompressive 
Compressive stress due to axial force N and bending moments My and Mz 
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σdelta 
Maximum difference between the normal stresses of the different load cases 
that are required, for example, for the fatigue design 

σtotal 
Normal stress due to axial force N and bending moments My and Mz 
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Table 3.2: Normal stresses σ 
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According to the common conventions, tensile stresses are indicated by positive signs and 
compressive stresses by negative signs. 

The local member axis system has a certain impact on the signs of the internal forces and 
stresses. 

 
Figure 3.7: Positive definition of internal forces  

The bending moment My is positive if tensile stresses are generated on the positive member 
side (in direction of the z-axis). Mz is positive if compressive stresses occur on the positive 
member side (in direction of the y-axis). The sign definition for torsional moments, axial 
forces and shear forces conforms to the usual conventions. These internal forces are positive 
if they act in a positive direction. 

The analysis is carried out for each single stress point so that normally the components of 
the maximum stresses must not be summed up for a combined calculation (for example 
σtotal): Often, the maximum stresses occur on different stress points. You have to superim-
pose the stress components of the respective stress point! 

Shear stresses 
The shear stresses τ have the following meanings: 

τV-y 

Stress due to shear force Vy 

tI

QV

z
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⋅

⋅
−=τ  

with Qz: static moment related to principal axis z 

 Iz: moment of inertia related to principal axis z 

 t: governing thickness of cross-section 

τV-z 

Stress due to shear force Vz 
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with Qy: static moment related to principal axis y 

 Iy: moment of inertia related to principal axis y 

 t: governing thickness of cross-section 

τV 

Stress due to shear forces Vy and Vz 
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τM-T, St.Venant 

Stress due to torsional moment MT in case of open cross-section 

t
J
M

.V.St

T ⋅=τ  

with JSt.V.: Saint Venant torsional constant 

 t: governing thickness of cross-section 

τM-T, Bredt 

Stress due to torsional moment MT in case of closed cross-section 

tA2
M

m

T

⋅⋅
=τ  

with Am: area enclosed by the center lines of the cross-section 

 t: governing thickness of cross-section 

τM-T 
Stress due to torsional moment MT 

t
J
M

.V.St

T ⋅=τ   or  
tA2

M

m

T

⋅⋅
=τ  

τtotal 
Shear stress due to shear forces Vy and Vz and torsional moment MT 

TMV τ+τ=τ  

Table 3.3: Shear stresses τ 

As the equations show, the program uses the static moments instead of the shear areas of 
the cross-section to determine the shear stresses due to shear force. 

Concerning the shear stresses due to torsion, please note the following: 

• If you have a cross-section that is partially open but has one closed cell, the program 
will classify the entire cross-section as closed. In this case, the shear stress will be de-
termined exclusively according to the Bredt formula. RF-STEEL Members won't carry 
out any pro-rata analysis for MT,St.Venant and MT,Bredt like it is done in the cross-section 
module SHAPE. 

• The influence of the warping torsion is not considered in RF-STEEL. The design, like 
the determination of internal forces in RFEM, is exclusively limited to the primary tor-
sional moment. However, if you have to consider warping stresses due to the sec-
ondary torsional moment or the warping bimoment, it is recommended to use the 
add-on module RF-FE-LTB for the analysis. 

Equivalent stress 
The equivalent stress σeqv, for example according to DIN 18800 part 1, el. (748), is deter-
mined as follows: 

σeqv 

Equivalent stress from normal stresses σ and shear stresses τ 
2
total2

2
total1eqv ff τ⋅+σ⋅=σ  

with f1: factor for normal stresses 

 f2: factor for shear stresses 

Table 3.4: Equivalent stress σeqv 

Factors f1 and f2 can be defined in the Details dialog box (see Figure 3.8, page 50). Accord-
ing to DIN 18800 part 1, el. (748), the factors are preset with f1 = 1.0 and f2 = 3.0. 
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Stress Ratio 
For stress designs, RF-STEEL Members determines the quotient from the existing and the 
limit stress, as described for example in DIN 18800 part 1, el. (747). 

For each internal force component, you can display the cross-section's stress ratio on the 
governing stress point (cf. chapter 4.2.2, page 70). The ratios due to normal, shear and 
equivalent stress are displayed in the results table by default. If the limit stress is not ex-
ceeded, the ratio is less than or equal to 1 and the stress design was carried out successful-
ly. 

1
d,R
≤

σ
σ

 

Equation 3.3: Design condition for normal stresses 

1
d,R
≤

τ
τ

 

Equation 3.4: Design condition for shear stresses 

1
d,R

eqv ≤
σ

σ
 

Equation 3.5: Design condition for equivalent stresses 

3.2.2 Calculation Details 
To check the different calculation parameters, open the corresponding dialog box by using 
the [Details] button. The dialog box can be accessed from any results table in the module. 

 
Figure 3.8: Dialog box Details 
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Display Result Tables 
This dialog section controls the display of the results tables. 

Table 2.5 Stresses at Every Stress Point is inactive by default as the stress graphic also pro-
vides access to the stress point results. However, for a detailed table check of the stresses, it 
may be useful to activate the table's display. 

The values displayed in table 3.1 Governing Internal Forces are generally related to the 
equivalent stress σeqv. Use the list to select another stress type. 

Method of Stress Calculation 
In case of a biaxial loading, it may occur that the combined member internal forces do not 
produce the maximum stresses. This is the case, for example, when a load case with vertical 
load has My moments but no Mz moments, and another load case with horizontal load has 
Mz moments but no My moments. Both load cases are superimposed with the setting "Vari-
able" in a load combination. In the RFEM table 3.5 Members - Internal Forces, the program 
will display the moment Mz as not corresponding to the maximum moment My because the 
horizontal load does not contribute to the increase of the moment due to vertical load. 
Therefore, in a separate design carried out only for the maximum moments My and Mz, a 
simultaneous influence of both internal forces on the combined bending stresses would not 
be considered. 

Stresses from Internal Forces 
The calculation method Stresses from Internal Forces uses the result rows of the RFEM table 
3.5 Members - Internal Forces. The max/min results are processed row by row. Thus, the 
program determines the stresses for each extreme value together with the corresponding 
internal forces. 

The advantage of this type of calculation is that the results of the load combinations can be 
used directly. This has a positive impact on the speed of the calculation. In addition, the de-
signed internal forces are transparent: In table 3.1 Governing Internal Forces, the module 
displays the result rows from the RFEM table 3.5 Members - Internal Forces. 

Calculate Stresses from Single Load Cases and then Combine 
This type of calculation is preset for the stress analysis of load combinations. The program 
determines the normal and shear stresses of the contained load cases and superimposes 
them subsequently according to the specified CO combination criteria. In this way, the pro-
gram ensures that the effects described above, in case of bending stresses that are each un-
iaxial, do not result in too low stress ratios. 

The analysis is carried out stress point by stress point. The compressive, tensile and shear 
stresses available in the single load cases are summed up respectively and then displayed in 
the results tables. The equivalent stress σeqv is an exception: It is determined by the compo-
nents of σtotal and τtotal. A superposition of equivalent stresses from the single load cases 
would not be correct and thus would result in too high stress ratios. However, this calcula-
tion method may produce problems in "Or" superpositions because the equivalent stresses 
determined according to this approach possibly do not occur in such a way. 

This type of calculation requires more computing time. Furthermore, the values displayed in 
table 3.1 Governing Internal Forces are more difficult to understand, in case they refer to 
the equivalent stresses. 

As pure uniaxial bending usually does not occur in complex spatial systems, both calcula-
tion methods are supposed to show the same stress ratios in the output. 

Cross-section Optimization 
If the optimization process does not gear towards the maximum stress ratio of 100 %, you 
can specify a different limit value in this input field. 
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Consider Plastification 
Allow Local Plastification 
Optionally, you can allow a Local Plastification for the design according to DIN 18800 part 
1, el. (749). This means that the equivalent stress σeqv may exceed the allowable limit stress 
by 10 % in small cross-section areas. RF-STEEL checks if both conditions mentioned in el. 
(749) are fulfilled for the assumption "small areas". 

d,RMN 8,0
y

σ⋅≤σ+σ  

Equation 3.6 

d,RMN 8,0
z

σ⋅≤σ+σ  

Equation 3.7 

If this is the case, the limit stress for the design of σeqv will be increased appropriately. 

Plastic shape factors αpl 

You can reduce the stresses by the Plastic Shape Factors αpl mentioned in DIN 18800 part 1, 
el. (750). This option refers to the normal stresses σM due to the bending moments My and 
Mz. 
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Equation 3.8 

If you use this plastification option, RF-STEEL applies the plastic shape factors αpl,y = 1.14 
and αpl,z = 1.25 which are suggested in the standard. The allowance of local plastification is 
applied exclusively to rolled I-shaped cross-sections. 

Calculation of Equivalent Stress Sigma-eqv 
In this dialog section, you can adjust the factors for the determination of the equivalent 
stress. 

2
total2

2
total1eqv ff τ⋅+σ⋅=σ  

with  f1: factor for normal stresses 

  f2: factor for shear stresses 

Equation 3.9 

The factors mentioned in DIN 18800 part 1, el. (748) are preset with f1 = 1.0 and f2 = 3.0. 

Eccentric Transverse Loads on I-Beams 
If transverse loads are introduced on the upper flange of beams, their influence on the 
bending stress in the lower flange decreases with the increasing cross-section depth. This is 
the reason why it is possible to consider eccentrically acting transverse loads by a simplified 
method for high I-sections: For each(!) rolled or welded symmetrical I-section that is set for 
design in the current RF-STEEL case, the stress due to the bending moment Mz is calculated 
only on the upper flange. In such a case, the program uses an equivalent cross-section with 
half of the moment of inertia Iz. 

The advantage of this option is that you can enter the loads in the RFEM model in relation 
to the centroidal axes in order to avoid torsion. As the ticked check box affects all symmet-
rical I-sections of the design case, it is recommended to create a separate RF-STEEL case for 
such high I-beams. 
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3.2.3 Start Calculation 
You can start the calculation out of each of the three input tables by clicking the [Calcula-
tion] button. 

RF-STEEL Members searches for the results of the load cases, load groups and load combi-
nations that should be designed. If they cannot be found, the program starts the RFEM cal-
culation to determine the design relevant internal forces. In this determination process, the 
calculation parameters preset in RFEM are applied. 

If you have specified an optimization of cross-sections (see chapter 6.2, page 83), the pro-
gram determines the required cross-sections first and calculates their stresses subsequently. 

You can also start the calculation for RF-STEEL Members out of the RFEM user interface. The 
add-on modules are listed in the dialog box To Calculate like load cases or load groups. To 
open the dialog box in RFEM, 

select To Calculate on the Calculate menu. 

The dialog box is shown in chapter Figure 2.14 on page 28. 

If the design cases of RF-STEEL are missing in the Not Calculated list, tick the check box 
Show Additional Modules. 

To calculate an RF-STEEL case directly, use the list in the RFEM toolbar. Select the relevant 
design case in the toolbar list and click the button [Results on/off]. 

 
Figure 3.9: Direct calculation of an RF-STEEL design case in RFEM 
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3.3 Results 
Table 2.1 Stresses by Cross-section is displayed immediately after the calculation. All 
stresses are shown in the results tables 2.1 to 2.5, sorted by different criteria. Tables 3.1 
and 3.2 contain the governing internal forces, tables 4.1 and 4.2 show the parts lists for the 
members and sets of members. 

In the Details dialog box, you can select the results tables that you want to display in par-
ticular (see Figure 3.8, page 50).  

To access the results tables, use the RF-STEEL navigator. You can also use the two buttons 
shown on the left or the function keys [F2] and [F3] to select the previous or subsequent 
table. 

Click [OK] to save the results and quit the add-on module RF-STEEL Members. 

In the following, the different results tables are described in sequence. Evaluating and 
checking results is described in chapter 4 Results Evaluation. 

3.3.1 Stresses by Cross-section 

 
Figure 3.10: Table 2.1 Stresses by Cross-section 

The table shows the maximum stress ratios of all designed members resulting from the se-
lected load cases, load groups and load combinations. The results are listed by cross-
sections. If you have a tapered member, both cross-section descriptions are displayed in the 
table row next to the section number. 

The stress components displayed in the column Stress Type are based on the settings se-
lected in the dialog box Stresses - Filter (see Figure 4.7, page 69). To open the dialog box, 
use the button shown on the left. 

Member No. 
For each cross-section and each stress type, the table shows the number of the member 
with the maximum stress ratio. 
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Location x 
The column shows the respective x-location where the member's maximum stress ratio oc-
cur. For the table output, the program uses the following RFEM member locations x: 

• Start and end node 

• Partition points according to possibly defined member division 

• Extreme values of internal forces 

S-Point No. 
The design is carried out on certain stress points of the cross-section. These points are cross-
section locations that are defined by centroidal distances, static moments and cross-section 
thicknesses. Due to these cross-section properties, the design according to equation Table 
3.2 and Table 3.3 is possible. 

All default cross-sections of the library as well as the SHAPE cross-sections are already pro-
vided with stress points on the design relevant cross-section locations. The parameters for 
user-defined cross-sections must be imported or defined manually. 

In the dialog graphic on the right, you can display the stress points together with their 
numbering. The currently selected stress point (that means the stress point of the table row 
where the pointer is placed) is highlighted in red. 

Use the button [Info about Current Cross-section] to check the stress point's properties. 
First, the dialog box Info about cross-section opens showing a list of all section properties. 
Below the dialog graphic, you find the button [Details of Stress Points] that provides access 
to the stress point information. 

 
Figure 3.11: Dialog box Info about cross-section and Stress Points 
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In the dialog box Stress Points (Figure 3.11), the relevant centroidal distances ey and ez are 
listed below y and z of the Coordinates column. Columns Qy and Qz of the Statical Moments 
of Area show the static moments in relation to the principal axis y or z. Thickness t 
represents the component thickness at the corresponding stress point. The values contained 
in the Warping column are not relevant for the design carried out with the add-on module 
RF-STEEL Members. 

The stress analysis is carried out for each single stress point so that normally the compo-
nents of the maximum stresses must not be summed up for a combined calculation (for ex-
ample σeqv): Often, the maximum stresses occur at different stress points. You have to supe-
rimpose the stress components of the respective stress point! To evaluate the stress point 
results, use table 2.5 (see chapter 3.3.5, page 59) or the dialog box Cross-section Values 
and Stress Diagram (see Figure 4.9, page 71). 

Load Case 
Column D shows the relevant load cases, load groups or load combinations that produce 
the maximum stress ratios. 

Stress Type 
The normal stresses σtotal, the shear stresses τtotal and the equivalent stresses σeqv are dis-
played by default. The determination of these stresses is documented in Table 3.2, Table 3.3 
and Table 3.4 on page 47 to 49. 

The stress components considered in the total stresses can be displayed as shown in Figure 
3.12 below. You can select the different stress components in the dialog box Stresses - Filter 
(see Figure 4.7, page 69). To access this dialog box, use the button shown on the left. 

Stress Existing 
This column displays the extreme values of the existing stresses determined according to the 
equations of Table 3.2, Table 3.3 and Table 3.4 shown on page 47 to 49. 

Stress Limiting 
This column shows the limit stresses of table 1.2 (see chapter 3.1.2, page 41). In particular, 
they are the following: 

• Limit normal stress σx as the allowable stress for actions due to bending moment and 
membrane force 

• Limit shear stress τ as the allowable shear stress due to shear and torsion 

• Limit equivalent stress σeqv as the allowable equivalent stress for the simultaneous ef-
fect of normal and shear stresses 

Stress Ratio 
For each stress component, RF-STEEL Members determines the quotient from the existing 
and the limit stress. If the limit stress is not exceeded, the ratio is less than or equal to 1 and 
the stress design was carried out successfully. 
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3.3.2 Stresses by Set of Members 

 
Figure 3.12: Table 2.2 Stresses by Set of Members 

This results table is only displayed when you have selected at least one set of members for 
the design in table 1.1 General Data (see chapter 3.1.1, page 39). The maximum stress ra-
tios listed in this table are sorted by sets of members. 

The advantage of this results output is that the design results of a complete structural 
group, for example a frame beam, are clearly arranged in one results table, which facilitates 
the results evaluation. 

Details on the columns can be found in the previous chapter 3.3.1. In addition, the column 
Member No. is displayed. It shows the number of the member that bears the maximum 
stress ratio within the set of members. 
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3.3.3 Stresses by Member 

 
Figure 3.13: Table 2.3 Stresses by Member 

This results table shows the maximum stress ratios sorted by member numbers. For each 
member, the program indicates the Location x on which the maximum ratio occurs. 

The different columns are described in detail in chapter 3.3.1 on page 54. 

3.3.4 Stresses by x-Location 

 
Figure 3.14: Table 2.4 Stresses by x-Location 
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For each member, the table shows the maximum stress ratios on each x-location that is de-
termined by the following types of RFEM divisions: 

• Start and end node 

• Partition points according to possibly defined member division 

• Specification of member division for member results in the Options tab of the RFEM 
dialog box Calculation Parameters 

• Extreme values of internal forces 

3.3.5 Stresses at Every Stress Point  

 
Figure 3.15: Table 2.5 Stresses at Every Stress Point 

As a results evaluation by stress points is not required in most cases, the table is not dis-
played by default. However, you can display it by using the Details dialog box (see Figure 
3.8, page 50). To open the dialog box, use the corresponding button shown on the left. 

The display of this results table includes a considerable amount of data. As the maximum 
stresses, and thus the governing stress points of RF-STEEL Members, are determined auto-
matically, you usually do not need the display of this table. 

For each member, the stresses are listed by Locations x and stress points. The different col-
umns of the table are described in detail in chapter 3.3.1 on page 54. 

As an alternative to this table, specific evaluation options are available for the previous 
tables, which can be accessed by clicking the button [Cross-section Values and Stress Dia-
gram]. The dialog box Cross-section Values and Stress Diagram opens (see Figure 4.9, page 
71) where you can evaluate the design results of every single stress point graphically and 
numerically. 
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3.3.6 Governing Internal Forces by Member 

 
Figure 3.16: Table 3.1 Governing Internal Forces by Member 

For each member, the table shows the governing constellation of internal forces that leads 
to the respective maximum stress ratio. By default, the output refers to the equivalent stress 
σeqv. In the Details dialog box (see Figure 3.8, page 50) that can be accessed by using the 
[Details] button, you can change the reference for another stress component. 

When analyzing load combinations, please note the following concerning the results out-
put: If you select Calculate Stresses from Single Load Cases in CO and then Combine 
Stresses according to CO Criteria (see Details dialog box, Figure 3.8, page 50), it is not poss-
ible to evaluate the result rows of the RFEM results table 3.5 Members - Internal Forces di-
rectly. The compressive, tensile and shear stresses resulting from the single load cases are 
summed up according to the superposition rules and then displayed as total stresses in the 
results tables. The equivalent stress σeqv, however, is determined with the components of 
σtotal and τtotal according to Table 3.4 on page 49. Thus, the internal forces displayed in ta-
ble 3.1 are not directly transparent, if they are related to the equivalent stresses. 

Location x 
The column shows the respective x-location for which the program has determined the 
member's maximum stress ratio. 

Load Case 
This column indicates the numbers of the load case, load group or load combination whose 
internal forces result in the maximum stress ratio on the member. 

Forces / Moments 
For each member, the governing normal and shear forces as well as the torsional and bend-
ing moments are displayed. 



3  RF-STEEL Members 

 61Program RF-STEEL © 2010 Dlubal Engineering Software 

3.3.7 Governing Internal Forces by Set of Member 

 
Figure 3.17: Table 3.2 Governing Internal Forces by Set of Member 

This results table is only displayed when you have selected at least one set of members for 
the design in table 1.1 General Data (see chapter 3.1.1, page 39). The governing internal 
forces are sorted by sets of members. 
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3.3.8 Parts List by Member 

 
Figure 3.18: Table 4.1 Parts List by Member 

Finally, RF-STEEL Members provides a summary of all cross-sections that are included in the 
design case. By default, the list contains only the designed members. If you want to display 
a parts list with all members of the structure, select the corresponding option in the Details 
dialog box (see Figure 3.8, page 50). 

Part No. 
The program assigns automatically part numbers for similar members. 

Cross-section 
This column lists the cross-section numbers and descriptions. 

Number Members 
This column shows for each part how much similar members are used. 

Length 
This column displays the respective length of an individual member. 

Tot Length 
This column shows the product that is determined from the two previous columns. 

Surf. Area 
For each part, the program indicates the surface area related to the total length. The sur-
face area is determined from the Surface of the cross-sections. You can find the relevant en-
try in the cross-section information, available in table 1.3 to 2.5 (see Figure 3.11, page 55). 

Volume 
The volume of a part is determined from the cross-sectional area and the total length. 
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Unit Weight 
The Unit Weight of the cross-section represents the mass in relation to the length of one 
meter. For tapered cross-sections, the program averages both cross-section properties. 

Weight 
The values of this column are determined from the product of the entries in column C and 
G. 

Tot Weight 
The final column indicates the total weight of the respective part. 

Sum 
At the bottom of the list, you find a summary of the summed up values of column B, D, E, F 
and I. The data field of the column Tot Weight shows the amount of steel that is required. 

3.3.9 Parts List by Set of Members 

 
Figure 3.19: Table 4.2 Parts List by Set of Members 

The final results table is only displayed when you have selected at least one set of members 
for the design in table 1.1 General Data (see chapter 3.1.1, page 39). The advantage of the 
output by sets of members is the display of a summarized parts list for particular structural 
groups (for example a frame beam). 

Details on the columns can be found in the previous chapter. When different cross-sections 
are used in the set of members, the program averages the surface area, the volume and the 
unit weight. 
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4. Results Evaluation 
The results of the stress analysis can be evaluated in numerous ways. A specific evaluation is 
already available due to the data arrangement in the tables. They present the results sorted 
according to particular criteria. In addition, the tables provide useful buttons. 

RF-STEEL Surfaces 

 
Figure 4.1: Buttons for results evaluation in the add-on module RF-STEEL Surfaces 

The buttons are reserved for the following functions: 

Button Description Function 

 Details 
Opens the Details dialog box to select the displayed 
stresses   chapter 4.1.1, page 66 

 View mode 
Opens the RFEM work window for a graphical check 
without closing RF-STEEL   chapter 4.1.2, page 67 

 Object selection 
Opens the RFEM work window to select a surface or line 
graphically 

 Result distribution 
Displays the results of the currently selected table row in 
the RFEM background graphic 

 Exceeding 
Displays only the table rows where the ratio is more 
than 1 

 Color bars 
Turns on and off the display of the colored relation 
scales in the results tables 

 Excel 
Exports the content of the current table to MS Excel or 
OpenOffice.org Calc   chapter 6.4, page 87 

Table 4.1: Buttons of results tables in RF-STEEL Surfaces 
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RF-STEEL Members 

 
Figure 4.2: Buttons for results evaluation in the add-on module RF-STEEL Members 

Button Description Function 

 Stress diagram 
Displays the stress diagram in the cross-section graphic 
above 

 Stress ratio 
Turns on and off the graphic display of the stress ratios, 
as an alternative to the stress diagram 

 Values Displays the values in the cross-section graphic 

 
Cross-section 
outlines 

Displays the cross-section's shape in the cross-section 
graphic 

 Stress points Displays the stress points in the cross-section graphic 

 Numbering 
Turns on and off the numbering of stress points in the 
cross-section graphic 

 Cross-section info
Opens the dialog box Info about cross-section showing 
the properties of the currently selected cross-section   
chapter 4.2.2, page 71 

 Result diagrams 
Opens the window Result Diagram on Member   chap-
ter 4.2.4, page 75 

 Color bars 
Turns on and off the display of the colored scales in the 
results tables 

 Exceeding 
Displays only the rows where the ratio is more than 1 
and the design is failed 

 Stress selection 
Opens the dialog box Stresses - Filter   chapter 4.2.1, 
page 69 
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 Detail display 
Opens the dialog box Cross-section Values and Stress 
Diagram   chapter 4.2.2, page 71 

 Full view 
Resets the stress graphic in full view (zooming by wheel 
button, moving by drag-and-drop) 

 View mode 
Opens the RFEM work window for a graphical check 
without closing RF-STEEL   chapter 4.2.3, page 72 

 Object selection 
Opens the RFEM work window to select a member 
graphically 

Table 4.2: Buttons of results tables in RF-STEEL Members 

4.1 RF-STEEL Surfaces 

4.1.1 Selection of Stresses 
The following stress types are displayed by default when the design has been carried out: 

• Shear stresses τmax 

• Principal stresses σ in direction of the principal axes on the surface's top and bottom 
side 

• Membrane stresses σm in direction of the principal axes 

• Equivalent stress σeqv 

• Membrane equivalent stress σeqv,m 

Use the [Details] button to select the stress types that you want to be displayed. 

 
Figure 4.3: Button [Start Dialog Box 'Details' and Select Stresses to Show] 

The Details dialog box appears (see Figure 2.11, page 19). In the Stresses tab, you can tick 
or clear the check boxes of the corresponding stress components that you want to display 
in the results table. All available stress types are shown on the left. 

The different stress components and their formulas are described in detail in chapter 
2.2.1.1, page 20. 

The settings in the Details dialog box influence the results tables as well as the printout re-
port. The stress components displayed in the tables can also be found in the printout. As 
you cannot select the stress types in the printout report (see chapter 5.1, page 78), you 
must specify the corresponding settings in the Details dialog box. 
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4.1.2 Results in the RFEM Model 

To evaluate the design results, you can use the RFEM work window. 

Background graphic and view mode 
The RFEM graphic in the background may be useful when you want to check the position of 
a particular surface in the model. An arrow in the RFEM background graphic indicates the 
location of the FE mesh or grid point that you have selected in the results table. When the 
button [Show Current Results] is set active, the current stresses are displayed additionally. 

 
Figure 4.4: Indication of the current FE mesh point in the RFEM model 

In case the graphic view cannot be displayed appropriately by moving the RF-STEEL module 
window, use the button [Jump to Graphics] to change to the view mode. The program 
hides the RF-STEEL window so that you can modify the display in the RFEM user interface. 
The view mode only provides the functions of the View menu, for example zooming, mov-
ing or rotating the display, as well as the partial view options. 

Click [Back] to return to the add-on module RF-STEEL Surfaces. 
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RFEM work window 
All stresses and stress ratios can be visualized directly in the structural model. Use the 
[Graphic] button to quit the RF-STEEL module. Now, you can evaluate the results, such as 
the internal forces of a load case or a load group, in the RFEM work window graphically. 

The Results navigator is adjusted to the design results from RF-STEEL. In the graphic, you 
can display and check the different stress types as well as the corresponding stress ratios for 
each of the designed actions. 

 
Figure 4.5: Results navigator to select stresses and stress ratios from designed actions 

To turn the display of design results on or off, use the button [Results on/off], as you know 
it from the RFEM internal forces. 

As the RFEM tables are of no relevance for the evaluation of RF-STEEL results, you may 
deactivate them. 

The design cases are selected as usual by means of the list in the RFEM menu bar. 

To display the surface results and the result values, you can use all options that are available 
in RFEM. The corresponding display functions are described in detail in chapter 10.4 of the 
RFEM manual. 

It is always possible to return to the RF-STEEL add-on module by clicking the button 
[RF-STEEL Surfaces] in the panel. 
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4.2 RF-STEEL Members 

4.2.1 Selection of Stresses 
The following stresses are displayed by default in the table display of the add-on module 
RF-STEEL Members: 

• Normal stress σtotal 

• Shear stress τtotal 

• Equivalent stress σeqv 

Use the button [Select Stresses to Show] to display further stress components. In this way, 
you can check the stress components integrated in the total stress. 

 
Figure 4.6: Button [Select Stresses to Show] 

The following dialog box appears: 

 
Figure 4.7: Dialog box Stresses - Filter 

In this dialog box, you can define the relevant stress components. The different stresses are 
described in Table 3.2 and Table 3.3 on page 47 and 49. 

The two dialog buttons facilitate the selection and are reserved for the following functions: 

Button Description Function 

 Select all All stress components are selected. 

 Deselect all All stresses are canceled. 

Table 4.3: Buttons in the dialog box Stresses - Filter 

The analysis is carried out for each single stress point so that normally the components of 
the maximum stresses must not be summed up for a combined calculation (for example 
σtotal): Often, the maximum stresses occur at different stress points. You have to superim-
pose the stress components of the respective stress point! 

The selection made in the dialog box Stresses - Filter affects also the printout report. The 
printout includes the stress components that are active in the tables. However, it is not 
possible to select stress types in the printout report (see chapter 5.1, page 78). 
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4.2.2 Results on the Cross-section 
In addition to the stresses listed in tables, a stress graphic is displayed on the right in the re-
sults tables. This graphic is dynamic, that means it shows the stress diagram of the current 
x-location and the current stress point that is determined by the pointer position in the ta-
ble. The currently selected stress point is highlighted in red in the graphic. 

 
Figure 4.8: Diagram of normal stresses on cross-section 

Use the wheel button to maximize or minimize the display. Use the drag-and-drop function 
to move the stress graphic. The button shown on the left resets the graphic's full view. 

The functions of the buttons below the graphic are described in Table 4.2 on page 66. Use 
these buttons to display 

• the stress or stress ratio diagram including values 

• the cross-section outlines 

• the stress points and their numbering. 

To evaluate the stresses for each stress point specifically, use the button [Show or Print 
Cross-section Values and Extended Stress Diagram]. The dialog box Cross-section Values and 
Stress Diagram opens (see Figure 4.9). 
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Figure 4.9: Dialog box Cross-section Values and Stress Diagram 

The current Member No. and the location x on the member are already preset in the dialog 
section Position. To select another member or x-location, use the list. 

The dialog section Stress Points lists all stress points of the cross-section. The two Coordi-
nates columns show the respective centroidal distances y and z. The Static Moments col-
umns display the corresponding static moments Qy and Qz. The final column contains the 
values of the Thickness t of the respective cross-section element. This thickness is relevant 
for the determination of shear stress. 

In the Stresses dialog section, the stress components are displayed in detail for the stress 
point that is currently selected in the dialog section above. To visualize a particular stress 
type in the dynamic graphic on the right, select it by clicking the relevant entry. 

Most of the buttons below the graphic are identical with the buttons in the results tables 
(see Table 4.2, page 66). As usual, they are described by ScreenTips. A special feature is 
provided by the [Print] button that enables the printout of the current stress graphic on the 
cross-section. For more information, see chapter 5.2.2, on page 80. 
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4.2.3 Results in the RFEM Model 

To evaluate the design results, you can use the RFEM work window. 

Background graphic and view mode 
The RFEM graphic in the background may be useful when you want to check the position of 
a particular member in the model. The member that is selected in the results table is hig-
hlighted in the RFEM background graphic in the selection color. In addition, an arrow indi-
cates the current x-location on the member. 

 
Figure 4.10: Indication of the member and the current Location x in the RFEM model 

In case the graphic view cannot be displayed appropriately by moving the RF-STEEL module 
window, use the button [Jump to Graphics] to change to the view mode. The program 
hides the RF-STEEL window so that you can modify the display in the RFEM user interface. 
The view mode only provides the functions of the View menu, for example zooming, mov-
ing or rotating the display, as well as the partial view options. 

Click [Back] to return to the add-on module RF-STEEL Members. 
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RFEM work window 
All stresses and stress ratios can be visualized directly in the structural model. Use the 
[Graphic] button to quit the RF-STEEL module. Now, you can evaluate the results, such as 
the internal forces of a load case or a load group, in the RFEM work window graphically. 

The Results navigator is adjusted to the design results from RF-STEEL Members. You can se-
lect the individual stress components as well as the stress ratios in relation to the respective 
stress components. 

 
Figure 4.11: Results navigator of RF-STEEL Members 

To turn the display of design results on or off, use the button [Results on/off], as you know 
it from the RFEM internal forces. To display the result values, use the toolbar button [Show 
Result Values] to the right. 

As the RFEM tables are of no relevance for the evaluation of stresses and stress ratios, you 
may deactivate them. 

The design cases are selected as usual by means of the list in the RFEM menu bar. 



4  Results Evaluation 

 74 Program RF-STEEL © 2010 Dlubal Engineering Software 

 

 

 
 

Stresses and stress ratios are two colored by default. To adjust the results display, use the 
Display navigator, select Results and then Members. 

 
Figure 4.12: Display navigator: Results → Members 

The stresses are represented with two colors, conforming to the signs. Positive stresses are 
displayed in blue, in direction of the positive member axis z. Negative stresses are red, ap-
plied in opposite direction. Thus, it is possible that the stress diagram on the member, in 
case of discontinuity, changes the sign and therefore the color and member side. 

In case of a multicolor display representation, a panel is available, providing the common 
control functions. The panel functions are described in detail in the RFEM manual, chapter 
4.4.6, page 77. In the Filter tab shown on the left, you can scale the design results, as you 
know it from the member internal forces. If you enter the factor 0 in the input field Member 
Diagrams, the stresses and stress ratios will be represented directly on the member axes 
with an increased line thickness. 

 
Figure 4.13: Stresses due to bending moments M with display option Cross-sections 

It is always possible to return to the RF-STEEL add-on module by clicking the button [RF-
STEEL Members] in the panel. 
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4.2.4 Result Diagrams 

To display the distribution of stresses and stress ratios for a particular member, you can also 
use the result diagram you already know from RFEM. First, select the member or set of 
member in the results table of RF-STEEL Members, and then click the button below the 
stress graphic shown on the left. 

Alternatively, the result diagrams are available in the RFEM graphic. To display the dia-
grams, 

select Result Diagrams on Selected Members on the Results menu, 

or use the button in the RFEM toolbar shown on the left. 

A window opens that shows the stress and stress ratio diagrams on the selected member or 
set of members. 

 
Figure 4.14: Dialog box Result Diagram on Member 

In the navigator on the left, define the types of stresses and stress ratios that you want to 
be displayed in the result diagram. Use the lists in the toolbar above to choose a particular 
design case or member. 

For more detailed information on the dialog box Result Diagram on Member, see the RFEM 
manual, chapter 10.5, page 311. 
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4.3 Filter for Results 
Due to their data arrangement, the RF-STEEL results tables already provide a specific selec-
tion according to certain criteria. In some detail tables, you find additional filter functions 
for structural objects and actions (see Figure 2.21, page 34). 

 
Figure 4.15: Filtering structural objects and actions in table 2.5 

In principle, you can use all filter functions described in the RFEM manual for the graphical 
evaluation of RF-STEEL design results. For example, you can activate or recreate partial views 
already defined (cf. RFEM manual, chapter 10.9, page 321) containing selected objects that 
are arranged appropriately. You may also use sections (cf. RFEM manual, chapter 10.6, 
page 313). 

In the RFEM work window, you can also use the stresses and stress ratios as filter criteria. 
The required specifications are defined in the panel. If the panel is not displayed, select 
Control Panel on the View menu in RFEM, or use the corresponding button in the Results 
toolbar. 

The panel is described in the RFEM manual, chapter 4.4.6, page 77. The filter settings for 
the results are defined by the color spectrum in the first panel tab. As this tab is not availa-
ble for the two colored results display of members, you have to set the display option Co-
lored or Cross-sections in the Display navigator (see Figure 4.13, page 74). 

You can use the panel, for example, to specify that only stresses higher than 100 N/mm2 are 
displayed. Furthermore, the color spectrum can be modified in such a way that a color 
range covers exactly 10 N/mm2. In this way, you may handle singularity effects for the do-
cumentation. 

 
Figure 4.16: Filtering equivalent stresses with adjusted color spectrum 
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Filtering surfaces and members 
In the Filter tab of the control panel, you can define the numbers of the surfaces or mem-
bers whose results diagrams should be displayed exclusively in the graphic. For more de-
tailed information, see the RFEM manual, chapter 10.9, page 321. 

In contrast to the partial view function, the structural model is now displayed completely in 
the graphic. The following figure shows the equivalent stresses of an internal hall frame. All 
the other designed members are displayed in the model, but are shown without stresses. 

 

Figure 4.17: Filtering members: equivalent stresses of a frame 
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5. Printout 
 

5.1 Printout Report 
As you know it from RFEM, the program generates a printout report for the RF-STEEL de-
sign results that can be added by graphics and descriptions. In this report, you also decide 
which results tables from RF-STEEL appear in the printout. 

The printout report is described in detail in the RFEM manual. In particular, chapter 11.1.3.4 
Selecting Data of Add-on Modules on page 338 provides information concerning the selec-
tion of input and output data in add-on modules. 

When your structure is quite extensive, it is advisable to split the data into several small re-
ports. For example, if you create a new printout report only for the data of a single design 
case from RF-STEEL Surfaces, this printout report will be generated relatively quickly. 

The printout report shows the stress components that are active in the results tables of the 
corresponding RF-STEEL design case. For example, if you want to show the stresses due to 
axial force in the printout, you have to activate the stresses σ1,m and σ2,m in RF-STEEL Sur-
faces. In RF-STEEL Members, you would have to select the stresses σN. The corresponding 
functions are described in chapter 4.1 RF-STEEL Surfaces on page 66 and 4.2 RF-STEEL 
Members on page 69. 

5.2 Print RF-STEEL Graphics 
As described in chapter 4 Results Evaluation, all stresses and stress ratios can be evaluated 
graphically. It is also possible to document each graphic by integrating it in the printout re-
port or sending it directly to the printer. 

Printing graphics is described in detail in the RFEM manual, chapter 11.2, page 354. 

5.2.1 Results in the RFEM Model 
Every picture that is displayed in the graphic window of the main program RFEM can be in-
tegrated in the printout report. The result diagrams of sections and members can be im-
ported to the report as well by using the [Print] button. 

To print the current RF-STEEL graphic in the RFEM work window, 

select Print on the File menu 

or use the toolbar button shown on the left. 

 
Figure 5.1: Button Print in the toolbar of the main window 

 
Figure 5.2: Button Print in the toolbar of the Result Diagram window 
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The following dialog box opens: 

 
Figure 5.3: Dialog box Graphic Printout, tab General 

This dialog box is described in detail in the RFEM manual, chapter 11.2, page 354. The 
RFEM manual also describes the Options and Color Spectrum tab. 

A graphic from RF-STEEL, that has been integrated in the printout report, can be moved an-
ywhere within the report by using the drag-and-drop function. 

In addition, it is possible to adjust imported graphics subsequently: Right-click the relevant 
entry in the navigator of the printout report and select Properties in the context menu. The 
dialog box Graphic Printout opens again, offering different options for modification. 

 
Figure 5.4: Dialog box Graphic Printout, tab Options 
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5.2.2 Results on the Cross-section 
In RF-STEEL Members, the access to the print function is not directly available. Instead, the 
corresponding button can be found in the dialog box Cross-section Values and Stress Dia-
gram. To open the dialog box, use the button [Print Cross-section Values and Extended 
Stress Diagram]. 

 
Figure 5.5: Button Show or Print Cross-section Values and Extended Stress Diagram in the graphic of the results tables 

In the dialog box Cross-section Values and Stress Diagram (see Figure 4.9, page 71), you 
specify the member, the relevant x-location and the stress type. To open the following 
printing dialog box, use the [Print] button at the bottom right in the dialog box. 

 
Figure 5.6: Dialog box Print Info about Cross-section 

In the dialog section Print Type, the common options are available for selection: 

• Direct to Printer sends the current graphic to the printer. 

• To Printout Report inserts the graphic into the printout report. 

• To Clipboard provides the graphic for other applications. 

If several printout reports are available, you can select the number of the target report in 
the selection field to the right. 
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In the dialog section Printout Selection, you decide which elements appear in the print 
graphic and in the output table. The objects listed under Create Graphics of Cross Section 
can each be displayed or hidden for the stress graphic. If you tick the check box for Cross-
section Properties, the cross-section properties will be printed as a table, optionally added 
by a symbolic Info Picture in the margin. In the same way, you can integrate the properties 
of the Stress Points and c/t-Parts as well as the Stresses in All Stress Points in the printout. 

When you click [OK], the printout report usually opens. If you want to import several graph-
ics consecutively into the printout report, clear the check box Show Printout Report on [OK]. 

 
Figure 5.7: Stress graphic in the printout report 
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6. General Functions 
The final chapter describes some menu functions as well as export options for the design 
results. 

6.1 RF-STEEL Design Cases 
Surfaces or members can be managed specifically in separate design cases. In this way, you 
can, for example, combine groups of structural components or define particular design spe-
cifications for them (limit stresses, partial safety factors, optimization etc.). 

It is no problem to analyze the same surface or member/set of member in different design 
cases. 

The RF-STEEL cases are available in the RFEM workspace and can be displayed like a load 
case or load group by means of the toolbar list. 

Create a new RF-STEEL case 
To create a new design case, 

select New Case on the File menu in the RF-STEEL add-on module. 

The following dialog box appears. 

 
Figure 6.1: Dialog box New RF-STEEL Surfaces-Case 

In this dialog box, enter a No. (which is not yet assigned) and a Description for the new de-
sign case. When you click [OK], table 1.1 General Data of the respective RF-STEEL add-on 
module opens where you can enter the new design data. 

Rename a RF-STEEL case 
To change the description of a design case subsequently, 

select Rename Case on the File menu in the RF-STEEL add-on module. 

The dialog box Rename RF-STEEL Surfaces-/Members-Case appears. 

 
Figure 6.2: Dialog box Rename RF-STEEL Surfaces-Case 
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Copy a RF-STEEL case 
To copy the input data of the current design case, 

select Copy Case on the File menu in the RF-STEEL add-on module. 

The dialog box Copy RF-STEEL Surfaces-/Members-Case appears where you can specify the 
number and description of the new case. 

 
Figure 6.3: Dialog box Copy RF-STEEL Surfaces-Case 

Delete a RF-STEEL case 
To delete design cases, 

select Delete Case on the File menu in the RF-STEEL add-on module. 

In the dialog box Delete Cases, you can select the relevant design case in the Available Cas-
es list to delete it by clicking [OK]. 

 
Figure 6.4: Dialog box Delete Cases 

6.2 Optimization 
In both RF-STEEL modules, it is possible to optimize the surface thicknesses or cross-
sections. During the optimization process, the program determines the surface thickness or 
cross-section within the respective cross-section table that fulfills the analysis requirements 
for the existing RFEM internal forces in the most optimal way, that means comes as close as 
possible to a user-defined maximum ratio. 

The maximum allowable stress ratio is defined in the Details dialog box (see Figure 2.13, 
page 26 or Figure 3.8, page 50). 

 
Figure 6.5: Specification of the maximum stress ratio 
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Please note that the internal forces won't be recalculated automatically with the changed 
surface thicknesses or cross-sections! It is up to you to decide when to use the initial or op-
timized surface thicknesses or cross-sections for a new calculation run in RFEM. As a result 
of optimized objects, internal forces may vary considerably because of the changed stiff-
nesses in the structural system. Therefore, it is recommended to recalculate the internal 
forces after the first optimization and then to modify the surface thicknesses or cross-
sections once again. 

6.2.1 RF-STEEL Surfaces 
During the optimization process, the program determines the surface thickness that comes 
as close as possible to the maximum stress ratio for the existing RFEM internal forces. 

The optimization options are only available in table 1.3 Surfaces. To optimize a particular 
surface, tick its corresponding check box in column D or E (see Figure 2.7, page 16). The fol-
lowing dialog box opens. 

 
Figure 6.6: Dialog box Optimization Parameters 

In the input fields Minimum and Maximum, you define the upper and lower limits of the al-
lowable surface thicknesses. The current thickness is also displayed so that you can compare 
the values. The Increment determines the interval in which the thickness may vary during 
the optimization process. 

When you have recalculated the data, table 1.3 Surfaces shows the optimized thicknesses. 
You do not need to transfer the new surface thicknesses to RFEM manually: Set table 1.3 
Surfaces, and then 

select Export All Surfaces to RFEM on the Edit menu. 

The context menu in table 1.3 also provides options to export modified surfaces to RFEM. 

 
Figure 6.7: Context menu in table 1.3 Surfaces 

By using the menu functions described above, you can also import the original RFEM sur-
faces to RF-STEEL Surfaces. Please note that this option is only available in table 1.3 Surfac-
es. 
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Context menu in results tables 

 

6.2.2 RF-STEEL Members 
To optimize a particular cross-section, tick its corresponding check box in column C or D of 
table 1.3 Cross-sections (cf. Figure 3.4, page 44). You can also start the cross-section opti-
mization out of the results tables by using the context menu. 

During the optimization process, RF-STEEL determines the cross-section within the specified 
cross-section table that fulfills the analysis requirements in the most optimal way, that 
means comes as close as possible to a user-defined maximum ratio. The program deter-
mines the second moment of area required for the RFEM internal forces and uses the cross-
section of the given cross-section table that completes the design with a stress ratio that is 
as high as possible. After the calculation, the graphic in table 1.3 Cross-sections shows two 
cross-sections: the original from RFEM and the optimized (cf. Figure 3.4, page 44). 

For parameterized cross-sections of the cross-section library, a dialog box with detailed spe-
cifications appears when you start the optimization process. 

 
Figure 6.8: Dialog box Welded Cross-sections - I unsymmetric : Optimize 

By ticking the check boxes in the Optimize column, you decide which parameter(s) you 
want to modify. The ticked check box enables the Minimal and Maximal columns that de-
fine the upper and lower limits of the corresponding parameter for the optimization. The 
Increment column determines the interval in which the parameter varies during the optimi-
zation process. 

If you want to Keep Current Side Proportions, tick the corresponding check box. In addi-
tion, you have to select at least two parameters for the optimization. 

For cross-sections based on combined rolled cross-sections, no optimization options are 
available. 

You do not need to transfer the modified cross-sections to RFEM manually: Set table 1.3 
Cross-sections, and then 

select Export All Cross-sections to RFEM on the Edit menu. 
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Also the context menu in table 1.3 provides options to export modified cross-sections to 
RFEM. 

 
Figure 6.9: Context menu in table 1.3 Cross-sections 

Before the changed cross-sections are transferred to RFEM, a security query appears, be-
cause the transfer requires the deletion of results. When you confirm the query and start 
the calculation subsequently in RF-STEEL Members, the RFEM internal forces as well as the 
RF-STEEL stresses are determined in one continuous calculation run. 

 
Figure 6.10: Query before transfer of modified cross-sections to RFEM 

By using the menu functions described above, you can also import the original RFEM cross-
sections to RF-STEEL Members. Please note that this option is only available in table 1.3 
Cross-sections. 

If you optimize a tapered member, the program modifies the member's start and end and 
interpolates the second moments of area for the intermediate locations. As these moments 
are considered with the fourth power, the stress determination may be inaccurate if the 
depths of the start and end cross-section differ considerably. In this case, it is recommended 
to divide the taper into several single members whose start and end cross-sections have mi-
nor cross-section differences. 
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6.3 Units and Decimal Places 
The units and decimal places for RFEM and all add-on modules are managed in one global 
dialog box. In both RF-STEEL modules, you can use the menu to adjust the units. To open 
the corresponding dialog box, 

select Units and Decimal Places on the Settings menu. 

The following dialog box opens, which you already know from RFEM. In the Program / 
Module list on the left, the relevant RF-STEEL Surfaces or RF-STEEL Members add-on module 
is already preset. 

 
Figure 6.11: Dialog box Units and Decimal Places 

The settings can be saved as user profile to reuse them in other structures. The functions 
are described in the RFEM manual, chapter 12.6.2, page 453. 

6.4 Export of Results 
The results of the stress analysis can be provided for other programs in various ways. 

Clipboard 
To copy cells selected in the RF-STEEL results tables to the clipboard, use the keyboard keys 
[Ctrl]+[C]. To insert the cells, for example in a word processing program, press [Ctrl]+[V]. 
The headers of the table columns won't be transferred. 

Printout report 
The data of the RF-STEEL add-on modules can be printed into the global printout report (cf. 
chapter 5.1, page 78) to export them subsequently. In the printout report, 

select Export to RTF File or BauText on the File menu. 

The function is described in detail in the RFEM manual, chapter 11.1.11, page 350. 
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Excel / OpenOffice 

RF-STEEL provides a function for the direct data export to MS Excel or OpenOffice.org Calc. 
In the RF-STEEL add-on module, 

select Export Tables on the File menu. 

The following export dialog box appears. 

 
Figure 6.12: Dialog box Export - MS Excel 

When you have selected the relevant parameters, start the export by clicking [OK]. Excel or 
OpenOffice will be started automatically. It is not necessary to run the programs in the 
background. 

 
Figure 6.13: Result in MS Excel: Table 2.3 Stresses by Surface 
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